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this system.
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Section 1: Introduction

Section 1: Introduction

This section includes contact information and a brief description
of SEASOFT-Win32 and its components.

How to Contact Sea-Bird

Sea-Bird Electronics, Inc.
1808 136" Place Northeast
Bellevue, Washington 98005 USA

Telephone; 425-643-9866

Fax: 425-643-9954

E-mail: seabird@seabird.com
Website: http://www.seabird.com
Business hours:

Monday-Friday, 0800 to 1800 Pacific Standard Time
(1600 to 0200 Universal Time)

Except from April to October, when we are on ‘ summer time’
(1500 to 0100 Universal Time)

Summary

Note:

SBE Data Processing-Win32 is
abbreviated as SBE Data Processing
throughout this manual.

SEASOFT-Win32 consists of modular, menu-driven routines for acquisition,
display, processing, and archiving of oceanographic data acquired with
Sea-Bird equipment. SEASOFT-Win32 is designed to work with a PC running
Win 95/98/NT.

SEASOFT-Win32 is actually several stand-alone programs:
* SEATERM and SeatermAF terminal programs that send commands to
instrument for status, data acquisition setup, dataretrieval, and diagnostics
e SEASAVE-WIin32 program that acquires real-time data
* PLOT39-Win32 program for plotting SBE 39 data
*  SBE Data Processing-Win32 program that converts, edits, and
processes data

The main emphasis of this manual isthe SBE Data Processing program.
SEATERM and SeatermAF are briefly covered in Section 4: Terminal
Program Modules.

Products Supported

SBE Data Processing supports the following Sea-Bird products:

* SBE911plus CTD system

*  SBE9plug17 SEARAM CTD system

* SBE 16 SEACAT C-T Recorder

*  SBE 16plus SEACAT C-T Recorder

*  SBE 19 SEACAT Profiler

e SBE 19plus SEACAT Profiler

e SBE 21 SEACAT Thermosalinograph

* SBE 25 SEALOGGER CTD

*  SBE 35 Thermometer

e SBE 37-SM and 37-IM MicroCAT Conductivity and Temperature
(optional pressure) Recorder

*  SBE 39 Temperature (optional pressure) Recorder

*  SBE 48 Hull Temperature Sensor
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Notes:

1. The following modules are stand-
alone Win 95/98/NT programs,
not included in SBE Data
Processing-Win32:

SEATERM terminal program
SeatermAF terminal program
SEASAVE-Win32 real-time
data acquisition program
PLOT39-Win32 plotting
program for SBE 39 data

2. The following modules from
SEASOFT-DOS are not yet
available in SBE Data
Processing-Win32:

CONTOUR
SEAPLOT
OXFIT
OXFITW
OXSAT
PHFIT
SEACALC

Software Modules

SEASOFT-Win32 includes the following modules:

Type Module Name | Module Description
Terminal SEATERM Interface with awide variety of Sea-
programs Bird instruments.
Send commandsto | Seater mAF Interface with Sea-Bird instruments
instrument for that power and operate water samplers
status, data without real-time communication to
acquisition setup, the surface
dataretrieval, (90208 Auto Fire Module and
diagnostics. See SBE 17plus V2 SEARAM).
Section 4.
Instrument CONFIGURE | Defineinstrument configuration and
configuration (equivalent to calibration coefficients.
See Section 5. SEACON in
DOS version)
Real-time data SEASAVE- Acquire real-time data, display raw
acquisition, Win32 archived data.
playback, DATA Convert raw data (.hex or .dat file) to
conversion CONVERSION | engineering units, and store converted
See SEASAVE for datain .cnv file.
Windows Manual | ROSETTE Summarize data from rosette (water
for SEASAVE SUMMARY sampler bottle) .rosfile, storing the
details. See resultsin .btl file.
Section 6 for other
modules.
File editing ASCII IN Add header information to a.asc file
See Section 7. containing ASCII data.
MARK SCAN | Create .bsr bottle scan range file from
.mrk datafile.
SECTION Extract rows of datafrom .cnv file.
SPLIT Split datain .cnv fileinto upcast and
downcast files.
STRIP Extract columns of data from
.cnv file.
TRANSLATE | Convert dataformat in .cnv file from
ASCII to binary, or vice versa.
Dataprocessing |ALIGNCTD Align datarelative to pressure
Performed on (typically used for conductivity,
converted data temperature, and oxygen).
froma.cnv file. BIN Average data, basing bins on pressure,
See Section 8. AVERAGE depth, scan number, or time range.
BUOYANCY Compute Brunt V& sdla buoyancy and
stability frequency.
CELL Perform conductivity thermal
THERMAL mass correction.
MASS
DERIVE Calculate salinity, density, sound
velocity, oxygen, potential
temperature, dynamic height, etc.
FILTER Low-pass filter columns of data.
LOOPEDIT Mark a scan with badflag if scan
fails pressure reversal or minimum
velocity tests.
WILD EDIT Mark a data value with badflag to
eliminate wild points.
WINDOW Filter data with triangle, cosine,
FILTER boxcar, gaussian, or median window.
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(continued)
Type Module Name | Module Description
Datadisplay and | ASCII OUT Output data portion and/or header
plotting portion from .cnv file to an ASCII
Performed on file (.asc for data, .hdr for header).
converted data Useful for exporting converted data
froma.cnv file. for processing by other software.
See Section 9 for CONTOUR Generate density contours to overlay
ASCII OUT. See on TSplots.
SEASOFT-DOS SEAPLOT Plot data (C, T, P aswell as derived
manual for variables). Plots can be screen
CONTOUR and dumped to a printer or plotted on an
SEAPLOT - these HP pen plotter or HP LaserJet I11.
modules are not yet Note that SEAPLOT can plot data at
avallablein any point after DATA
Windows version. CONVERSION has been run.
Calibration OXFIT Compute oxygen coefficients.
See SEASOFT- OXFITW Compute oxygen coefficients using
DOS manual - Winkler titration values.
these modulesare | OXSAT Compute oxygen saturation as a
not yet availablein function of temperature and salinity.
Windows version. | PHFIT Compute pH coefficients.
Miscellaneous SEACALC Calculate derived variables.

See SEASOFT-
DOS manual - this
moduleis not yet
availablein
Windows version.

Differences from SEASOFT-DOS

SEASOFT was previoudly availablein aDOS version (SEASOFT-DOS).
Following are the differences between SEASOFT-Win32 and

SEASOFT-DOS:

1. SBE Data Processing does not include yet the following data processing
modules that are available in SEASOFT-DOS:
» DataDisplay Modules - CONTOUR and SEAPLOT
e Cadibration Modules - OXSAT, OXFIT, OXFITW, and PHFIT
e Miscellaneous Modules - SEACALC

2. SEASOFT-Win32 includes several stand-alone programs; you can install

any or al of these programs as desired:

*  SBE Data Processing-Win32

e Terminal Programs - Windows-based terminal programs SEATERM
and SeatermAF replace the terminal programsin SEASOFT-DOS
(TERM1621, TERM17, TERM19, TERM25, TERM37, TERMAFM,
TERM11, and TMODEM).

*  SEASAVE-Win32 - Windows-based SEASAVE replaces SEASAVE
in SEASOFT-DOS.

*  PLOT39-Win32 - Windows-based plotting program for SBE 39 data.

3. The SBE 9plus (with SBE 11plus Deck Unit or SBE 17 SEARAM) isthe
only version of the SBE 9 that is supported in SBE Data Processing.
Sea-Bird has been manufacturing the SBE 9plus since 1991.

The SBE 31 is not supported in SBE Data Processing.
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Section 2: SBE Data Processing
Installation and Use

SBE Data Processing requires approximately 40 Mbytes of disk space during
installation. Ensure there is room on your hard drive before proceeding.

SBE Data Processing Installation

Note:

Sea-Bird supplies the current version

of our software when you purchase

an instrument. As software revisions
occur, we post the revised software
on our FTP site.

« You may not need the latest
version. Our revisions often include
improvements and new features
related to one instrument, which
may have little or no impact on
your operation.

See our website (www.seabird.com)

for the latest software version

number, a description of the software
changes, and instructions for
downloading the software from the

FTP site.

1.

If not already installed, install SBE Data Processing and other Sea-Bird
software programs on your computer using the supplied software CD:

A. Insert the CD inyour CD drive.

B. Doubleclick on the Seasoft-Win32 directory.

C. Double click on Seasoft-Win32.exe.

D. Follow the dialog box directionsto install the software.

The default location for the software is c:/Program Files/Sea-Bird. Within
that folder is a sub-directory for each program.



Section 2: SBE Data Processing Installation and Use

SBE Data Processing Use

Note:

SBE Data Processing modules can
be run from the command line. Also,
batch file processing can be used to
process a batch file to automate data
processing tasks. See Appendix I:
Run Options, Command Line
Operation, and Batch File Processing
for details.

SBE Data Processing Window
Start the SBE Data Processing program by:

Double clicking on SBEDataProc.exe

(default location c:/Program Files/Sea-Bird/SBEDataProcessing-Win32),
or

(for Windows 98) Left clicking on Start and following the path
Programs/Sea-Bird/SBEDataProcessing-Win32

The SBE Data Processing window looks like this:

| Bun Configurs  Help

EZ SBE Data Processing M=l B3 I

1. Align CTD...
2 ASCH .
3. ASCH Dut... —

=8

B Cell Thermal Mass...

7. Data Conversian,..

B Defive..

3 Filter...

10 Loop Edi..
11 Mark Soan,..
13 Section...

14 Spht..
15. Stip:..

1B, Translate.

17, Wild Edit...

1B Wihdow Filter..

Fiuin Options.
Exit

The window’ s menus are described bel ow.

Run -

» List of the post-processing modules: Select the desired module to set
up the module parameters and process data. Module Dialog Box in
this section provides an overview of the post-processing module
dialog box; Sections 6 through 9 provide the details for each module.

» Run Options: Select Run Optionsto assist in automating processing.
See Appendix |: Run Options, Command Line Operation, and Batch
File Processing for details.

» Exit: Select to exit the program.

Configure - contains alist of Sea-Bird instruments that require a
configuration (.con) file. Select the desired instrument to modify or create
a.con filefor that instrument. The .con file defines the number and type
of sensorsinterfacing with the instrument, as well as the sensor calibration
coefficients. See Section 5: Configuring the Instrument for details.

Help - contains general program help files as well as context-specific help.
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Module Dialog Box

To open a post-processing module, select it in the Run menu of the SBE Data
Processing window. Each modul€’ s dialog box has three menus:

File -

VVVYVYVY

Start Process - begin to process data as defined in dialog box

Open - select adifferent program setup (.psu) file

Save or Save As - save al current settingsto a.psu file

Restore - reset all settings to match last saved .psu file

Default File Setup - reset all settings on File Setup tab to defaults
Default Data Setup - reset all settings on Data Setup tab to defaults
Exit or Save & Exit - exit module and return to SBE Data
Processing window

Options (where applicable) -

>

Confirm Program Setup Change - If selected, program provides a
prompt to save the program setup (.psu) file if you make changes and
click the Exit button or select Exit in the File menu without clicking
or selecting Save or Save As. If not selected, program changes
Exit to Save & Exit; to exit without saving changes, use the
Cancel button.

Confirm Instrument Configuration Change - If selected, program
provides a prompt to save the configuration (.con) fileif you make
changes and then click the Exit button in the Configuration dialog
box without clicking Save or Save As. If not selected, program
changes Exit button to Save & Exit; to exit without saving
changes, use the Cancel button.

Overwrite Output File Warning - If selected, program provides a
warning if output data will overwrite an existing file. If not selected,
program automatically overwrites an existing file with the same
file name asthe output file.

Inconsistent Output Variables Warning - If selected, program
provides awarning if the configuration (.con) file and/or the input
datafile are inconsistent with the selected output variables. For
example, if the user-selected output variables include conductivity
difference, but you remove the second conductivity sensor from the
.con file, awarning will appear. The warning details what output
variable cannot be calculated, and allows you to retain the change to
the .con file (and remove the inconsistent output variable) or restore
the .con file to the previous configuration. If not selected, program
automatically changesthe user-selected output variablesto be
consistent with the selected configuration or datafile.

Help - contains general program help files as well as context-specific help
(where applicable)

Each module’ s dialog box typically has three tabs - File Setup, Data Setup,
and Header View. The File Setup and Header View tabs are similar for all the
modules, and are discussed below. The Data Setup tab contains input
parameters specific to the module - see the module discussions in Sections 6
through 9 for details.

10
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Fie Oplors  Help
File Setup | Duata Senp | Huades View |

Input instrument
configuration file (.con)
location. This file controls
what data is available in
the Data Setup tab. Select
to pick a different file, or
Modify to view and/or
modify instrument
configuration.

Directory and file names
for input data. Select to
pick a different file. To
process multiple data files
from same directory:

1. Click Select.

2. In Select dialog box,
hold down Ctrl key
while clicking on each
desired file.

If multiple files are

selected, header in each

file must contain same set
of sensors and variables.

Click Start Process to
begin processing data.
Status field shows
Processing complete
when done.

The following examples and discussion of the File Setup and Header View
tabsisfor DATA CONVERSION. The other modules are similar; however,
not all fields are applicable to all modules.

File Setup Tab

File to store all information input in File Setup and Data Setup tabs. Open to
select a different .psu file, Save or Save As to save current settings, or Restore
to reset all settings to match last saved version.

As a default, .psu file is stored in same directory as SBEDataProc.exe (default is
c:/Program Files/Sea-Bird/SBEDataProcessing-Win32). PostProcSuite.ini, located
in Windows directory, contains location and file name of last saved .psu file and
options settings for each module.

Program setup fs

|I' WakahDisbbet, 151D S, P

Select if more than 1 data file is to be
processed, and data files have different

|Irshument corhgurshon His

) | |.’_'5-|i'-.TE3.':'..' 'J Azt | configuration (.con) files. For example, if

processing test.dat and testl.dat, and this
option is selected, program will search for
testl.con (in same directory as test.con) to

|I' Yk’ Dhhbae ' mibeak oo

Select. | Moddy..

| I‘«ﬁm/mmm:amm

It descioy

process testl.dat.

[H \data\Dubbieh 121
Irpuk files, 1 selected

|l:e5: dat
Dutpul diechoy

=] Seeat |

{H sl s\ Dhabbaeh 151

Sedact I

Fame: apperid |

Orutgrant b

Ill;l'.l =

Mol piocessng

Directory and file names for output data.

« If more than 1 data file is to be processed, Output file field disappears
and output file name is set to match input file name. For example,
if processing test.dat and test1.dat, output files will be test.cnv
and testl.cnv.

+ SBE Data Processing adds Name append to (each) output file name,
before extension. For example, if processing test.dat and test1.dat
with a Name append of datcnv, output files will be testdatcnv.cnv and
testldatcnv.cnv. Use Name append to save intermediate data files
when input and output files have same extension.

AN
Start Process

/Eln:i: Carce|
/

/

Return to SBE Data Processing window.

If Confirm Program Setup Change was selected in
Options menu - If you made changes and did

not Save or Save As, program asks if you want to

save changes.

If Confirm Program Setup Change was not selected
in Options menu - This button says Save & Exit.
If you do not want to save changes, use Cancel

button to exit.

11
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Header View Tab

B haka Coshided §iod

Fie Dpfions Heip

View existing header in input file(s). If
Fie Setup | Dala Setup  Header View | multiple input files are to be processed,
| E |/ switch between input file headers by
using Prior and Next buttons.

[=En =

* Gna-find SHE 3 R Diaha File ;J
* et e w CACTDDAT AW D22 0T

* 5 olftvase Vet s 4 216

* Tampeshms 5K = 7137

" ooty SH = 15532

* Murnkeer of Byles Pt Sosn = 27

* hharha of Vellaga Wad: = 3

* Eymbem L plosd Tire =.Jan 10 19585 185051

* lytouider 55 OO

*lorsplucla 173 OE

EHDT 1. Header lines beginning with * contain header

information copied from raw input data file.

» Header lines beginning with # contain header
information describing input converted data (.cnv) file
(not applicable to example shown). As each module is
run, it adds information to the header, such as the input
file name for the module, date and time the module
was run, and input parameters. Thus, the header
contains a complete record of how the data has been

converted, edited, and manipulated.

Begin processing data. - . .
Status field on File Setup tab » ASCII string *END* flags end of header information. -

shows Processing complete 51 }

when done.
\Eml Pricess | [ Esl | cace |

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu -
If you made changes in the File Setup or Data Setup tab and did not
Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu -
This button says Save & Exit. If you do not want to save changes made
on the File Setup or Data Setup tab, use Cancel button to exit.

12
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File Formats

File extensions are used by SEASOFT to indicate the file type:

Extension |Description

.afm Bottle sequence, date and time, firing confirmation, and 5 scans of CTD
data, created by 90208 Auto Fire Module

.asc Data portion of .cnv converted data file written in ASCI| by
ASCII OUT, or
Files written by SEATERM for an SBE 37-IM, 37-SM, or 39.

(Note: Convert button on SEATERM'’ stoolbar can convert .asc fileto
.cnv file that can be used by SBE Data Processing to process data.)

bl Bottle sequence number, position, date, time, and beginning and ending
scan humbers, created by SEASAV E when bottle fire confirmation
received.

bsr Bottle scan range file created by MARK SCAN, and used by DATA
CONVERSION to create a .rosfile.

btl Averaged and derived bottle datafrom a.rosfile, created by
ROSETTE SUMMARY .

.cnv Converted (engineering units) datafile, with an ASCII header preceding
data. Created by DATA CONVERSION, or by SEATERM’s Convert
button (SE 37-IM, 37-SM, or 39 only).

.con Instrument configuration (number and type of sensors) and calibration
coefficients. Created in CONFIGURE; used (and can be modified) in
SEASAVE, DATA CONVERSION, DERIVE, and ROSETTE
SUMMARY.

Cctr Density contour file generated by CONTOUR.

dat Raw binary data, optionally with header information, for SBE 911plus,
and data files created with older versions of SEASOFT-DOS.

.dsp Data acquisition and display parameters, stored by SEASAVE.

hdr Header portion of .cnv converted data file written by ASCII OUT, or
Header recorded when acquiring real-time data or uploading
archived data.

‘hex Raw HEX datawith header information, for SBE 16, 16plus,
17plus (used with 9plus), 19, 19plus, 21, and 25.

mrk Marker file created by SEASAVE during real-time data acquisition to
indicate bottle closures.

plt Display parameters stored by SEAPLOT.

.psu File containing input file name and data path, output data path, and
modul e-specific parameters used by SBE Data Processing modules.

ros File containing data for each scan associated with a bottle closure, as

well as data for a user-selected range of scans before and after each
closure; created by DATA CONVERSION.

Converted Data File (.cnv) Format
Converted files consist of a descriptive header followed by converted datain
engineering units.

The header contains:
1. Header information from the raw input data file (these lines begin with *)
2. Header information describing the converted data file (these lines begin
with #). The descriptions include:
*  number of rows and columns of data
» variablefor each column (for example, pressure, temperature, etc.)
* interval between each row (scan rate or bin size)
» historical record of processing steps that were used to create or
modify file
3. ASCII string *END to flag the end of the header information

The converted datais stored in either rows and columns of ASCII numbers
(11 characters per value) or as a binary data stream with each value stored as a
4 byte binary floating point number. The last data columnis aflag field used
to mark scansasbad in LOOP EDIT.
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Section 3: Typical Data Processing Sequences

Section 3:

Typical Data Processing Sequences

Notes:

1. SEAPLOT can display data at any
point after DATA CONVERSION has
been run.

2.Use ASCII OUT to export
converted data (without header) to
other software.

3. Oxygen values computed by
SEASAVE and DATA
CONVERSION differ from values
computed by DERIVE. Both
algorithms use the derivative of
oxygen current with respect to
time (doc/dt):

» Quick estimate - SEASAVE and
DATA CONVERSION compute
doc/dt looking back in time,
because SEASAVE cannot use
future values while acquiring real-
time data.

» Most accurate results - DERIVE
uses a centered window (equal
number of points before and after
scan) to compute doc/dt.

Following are typical data processing sequences for each instrument.
These sequences (and any values given for aligning and filtering data) are
based on atypical situation with aboat at low |atitude lowering an instrument

at 1 meter/second.

These examples assume that a configuration (.con) file is available for the
instrument. Note that a.con fileis provided by Sea-Bird when the instrument
is purchased, based on the user-specified configuration and the factory-
calibration. An existing .con file can be modified whilein SEASAVE or in the
DATA CONVERSION, DERIVE, or ROSETTE SUMMARY module,

if desired. If you do not have a.con file for the instrument, first run
CONFIGURE from SBE Data Processing’s Configure menu to create the

.confile.

Minimum Processing of Data

Program / Module

Function

1.SEASAVE, Acquire raw data.
SEATERM, or
Seater mAF
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted data includes:

e pressure, temperature, and conductivity
(dependent on instrument options selected)

o (if auxiliary sensors are part of system) oxygen
concentration, light transmission, etc.

e (if applicable) derived parameters such as
salinity, density, and sound velocity

Typical Processing of SBE 16, 16plus, and 21 Data

Program/Module | Function
1. SEASAVE or Acquire raw data.
SEATERM
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted dataincludes:
e pressure, temperature, and conductivity
(dependent on instrument options selected)
e (if auxiliary sensors are part of system) oxygen
concentration, light transmission, etc.
e (if applicable) derived parameters such as
salinity, density, and sound velocity
3. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 19 Data
Pumped SBE 19

Note:
For the SBE 19plus, see Typical
Processing of SBE 19plus Data.

Without Oxygen Sensor

Program/ Module

Function

1. SEASAVE or Acquire raw data.
SEATERM
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted data includes:
e pressure, temperature, and conductivity
e (if auxiliary sensors are part of system) light
transmission, pH, fluorescence, etc.

3. FILTER ¢ Low-pass filter conductivity with atime constant
of approximately 0.5 secondsto force
conductivity to have same response as
temperature.

e Low-passfilter pressure with atime constant of
2 seconds to increase pressure resolution for
LOOPEDIT.

4. ALIGNCTD Advance temperature rel ative to pressure

approximately +0.5 seconds.

5. LOOPEDIT Mark scans where CTD is moving less than minimum

velocity or travelling backwards due to ship roll.

6. BIN AVERAGE | Average datainto desired pressure or depth bins.

7. DERIVE Compute salinity, density, and other parameters.

With Oxygen Sensor

Program / Module

Function

1. SEASAVE or Acquire raw data.
SEATERM

2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted dataincludes:

e pressure, temperature, and conductivity

« dissolved oxygen current and dissolved oxygen
temperature

e (if other auxiliary sensors are part of system)
light transmission, etc.

3. FILTER ¢ Low-passfilter conductivity with atime constant
of approximately 0.5 secondsto force
conductivity to have same response as
temperature,

e Low-passfilter pressure with atime constant of
2 seconds to increase pressure resolution for
LOOP EDIT.

4. ALIGNCTD «  Advance temperature relative to pressure
approximately +0.5 seconds.

*  Advance oxygen relative to pressure
approximately +3 to +7 seconds. Note that this
value depends on oxygen sensor response time.

5. LOOPEDIT Mark scans where CTD is moving less than minimum

velocity or travelling backwards due to ship roll.

6. DERIVE Compute oxygen from oxygen current, oxygen

temperature, temperature, and pressure.

7. BIN AVERAGE | Average datainto desired pressure or depth bins.

8. DERIVE Compute salinity, density, and other parameters.
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Unpumped SBE 19

Without Oxygen Sensor

Program/Module | Function
1. SEASAVE or Acquire raw data.
SEATERM
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted data includes:
e pressure, temperature, and conductivity
e (if auxiliary sensors are part of system) light
transmission, pH, fluorescence, etc.

3. FILTER ¢ Low-pass filter conductivity with atime constant
of approximately 0.5 seconds, to force
conductivity to have same response as
temperature.

e Low-passfilter pressure with atime constant of
2 seconds to increase pressure resolution for
LOOPEDIT.

4. ALIGNCTD Advance temperature rel ative to pressure
approximately +0.5 seconds. Note that this value
depends on descent rate of CTD through water.

5. LOOPEDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. BIN AVERAGE | Average datainto desired pressure or depth bins.

7. DERIVE Compute salinity, density, and other parameters.

With Oxygen Sensor

Program/Module | Function
1. SEASAVE or Acquire raw data.
SEATERM
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted dataincludes:
e pressure, temperature, and conductivity
« dissolved oxygen current and dissolved oxygen
temperature
e (if other auxiliary sensors are part of system)
light transmission, etc.

3. FILTER ¢ Low-passfilter conductivity with atime constant
of approximately 0.5 secondsto force
conductivity to have same response as
temperature.

e Low-passfilter pressure with atime constant of
2 seconds to increase pressure resolution for
LOOPEDIT.

4. ALIGNCTD «  Advance temperature relative to pressure
approximately +0.5 seconds.

e Advance oxygen relative to pressure
approximately +1 to +5 seconds.

Note that these values depend on descent rate of CTD

through water and oxygen sensor response time.

5. LOOPEDIT Mark scans where CTD is moving less than minimum

velocity or travelling backwards due to ship roll.

6. DERIVE Compute oxygen from oxygen current, oxygen

temperature, temperature, and pressure.

7. BIN AVERAGE | Average datainto desired pressure or depth bins.

8. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 19plus Data
Pumped, Without Oxygen Sensor

Program/Module | Function
1. SEASAVE or Acquire raw data.
SEATERM
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted data includes:
e pressure, temperature, and conductivity
e (if auxiliary sensors are part of system) light
transmission, pH, fluorescence, etc.

3. FILTER Low-pass filter conductivity with atime constant of
approximately 0.5 seconds to force conductivity to
have same response as temperature.

4. ALIGNCTD Advance temperature relative to pressure
approximately +0.5 seconds.

5. LOOPEDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. BIN AVERAGE | Average datainto desired pressure or depth hins.

7. DERIVE Compute salinity, density, and other parameters.

Pumped, With Oxygen Sensor

Program/Module | Function

1. SEASAVE or Acquire raw data.
SEATERM

2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted dataincludes:

e pressure, temperature, and conductivity

« dissolved oxygen current and dissolved oxygen
temperature

e (if other auxiliary sensors are part of system)
light transmission, etc.

3. FILTER Low-pass filter conductivity with atime constant of
approximately 0.5 seconds to force conductivity to
have same response as temperature.

4. ALIGNCTD ¢ Advancetemperature relative to pressure

approximately +0.5 seconds.

e Advance oxygen relative to pressure
approximately +3 to +7 seconds. Note that this
value depends on oxygen sensor response time.

5. LOOPEDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. DERIVE Compute oxygen from oxygen current, oxygen
temperature, temperature, and pressure.

7. BIN AVERAGE | Average datainto desired pressure or depth bins.

8. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 25 Data
Pumped, Without Oxygen Sensor

Program/Module | Function
1. SEASAVE or Acquire raw data.
SEATERM
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted data includes:
e pressure, temperature, and conductivity
e (if auxiliary sensors are part of system) light
transmission, pH, fluorescence, etc.
3. FILTER Low-pass filter pressure with atime constant of
0.5 seconds to increase pressure resolution for
LOOPEDIT.
4. LOOPEDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.
5. BIN AVERAGE | Average datainto desired pressure or depth bins.
6. DERIVE Compute salinity, density, and other parameters.

Pumped, With Oxygen Sensor

Program/Module | Function
1. SEASAVE or Acquire raw data.
SEATERM
2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted dataincludes:
e pressure, temperature, and conductivity
« dissolved oxygen current and dissolved oxygen
temperature
e (if other auxiliary sensors are part of system)
light transmission, etc.

3. ALIGNCTD Advance oxygen relative to pressure approximately
+3 to +7 seconds. Note that this value depends on
descent rate and oxygen sensor response time.

4. FILTER Low-pass filter pressure with atime constant of
0.5 seconds to increase pressure resolution for
LOOP EDIT.

5. LOOPEDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

6. DERIVE Compute oxygen from oxygen current, oxygen
temperature, temperature, and pressure.

7. BIN AVERAGE | Average datainto desired pressure or depth bins.

8. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 911plus Data

Notes:

1. These examples assume the
SBE 11plus Deck Unit has been
set to correctly advance
conductivity relative to pressure
(1.75 scans, 0.073 seconds) for
911plus systems with a TC Duct.
If desired, use ALIGN CTD to
verify this by adding positive and
negative advances to
conductivity and observing the
effect on salinity and density
computed by DERIVE.

2.FILTER can be run before CELL
THERMAL MASS to remove any
residual response time between
the temperature and conductivity
sensors and to minimize
digitization noise. Typically, a
low-pass filter with 0.03 second
time constant slightly reduces the
noise in computed salinity. A low-
pass filter with a time constant
can be used to smooth the
pressure data, particularly when
examining full rate (24Hz) fine
structure data on pressure scales
of 10 meters (33 ft) or less.

Pumped, Without Oxygen Sensor

Program/Module | Function

1. SEASAVE Acquire raw data.

2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted data includes:

e pressure, temperature, and conductivity
e (if auxiliary sensors are part of system) light
transmission, pH, fluorescence, etc.

3. CELL Perform conductivity cell thermal mass correction if
THERMAL salinity accuracies of better than 0.01 PSU in regions
MASS with steep gradients are desired. Typical values are

alpha=0.03 and 1/beta=7.0.

4. FILTER Low-pass filter pressure with atime constant of

0.15 seconds to increase pressure resolution for
LOOPEDIT.

5. LOOPEDIT Mark scans where CTD is moving less than minimum

velocity or travelling backwards due to ship roll.

6. BIN AVERAGE | Average datainto desired pressure or depth bins.

7. DERIVE Compute salinity, density, and other parameters.

Pumped, With Oxygen Sensor

Program/Module | Function

1. SEASAVE Acquire raw data.

2. DATA Convert raw data, selecting ASCI| as data conversion
CONVERSION | format. Converted dataincludes:

e pressure, temperature, and conductivity

« dissolved oxygen current and dissolved oxygen
temperature

e (if other auxiliary sensors are part of system)
light transmission, etc.

3. ALIGNCTD Advance oxygen relative to pressure approximately
+2 to +5 seconds. Note that this value depends on
0Xygen Sensor response time.

4. CELL Perform conductivity cell thermal mass correction if
THERMAL salinity accuracies of better than 0.01 PSU in regions
MASS with steep gradients are desired. Typical values are

alpha=0.03 and 1/beta=7.0.

5. FILTER Low-pass filter pressure with atime constant of
0.15 seconds to increase pressure resolution for
LOOPEDIT.

6. LOOPEDIT Mark scans where CTD is moving less than minimum
velocity or travelling backwards due to ship roll.

7. DERIVE Compute oxygen from oxygen current, oxygen
temperature, temperature, and pressure.

8. BIN AVERAGE | Average datainto desired pressure or depth bins.

9. DERIVE Compute salinity, density, and other parameters.
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Typical Processing of SBE 37-SM, 37-IM, and 39 Data

Program / Module

Function

1. SEATERM and
Convert button
on SEATERM
toolbar

Upload data (in engineering units) in ASCII (.asc)
format. Use Convert button to convert .asc file to
.cnv file, which can be used by SBE Data Processing
modules.

2. DERIVE

As applicable, compute salinity, density, and other
parameters.

Note: An SBE 37-SM, 37-IM, and 39 stores
calibration coefficientsinternally, and does not have a
.con file. However, DERIVE requires you to select a
.con file before it will process data. Select any .con
file (or create and select an empty file with a.con
extension) - the contents of the file will not affect the
results for these instruments.
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Section 4: Terminal Program Modules

Section 4: Terminal Program Modules

Note:

See the instrument User
Manual or the Terminal
Program module’s Help files for
specific communication settings
and commands.

Terminal programs send commands to instruments to provide status, data
acquisition setup, dataretrieval, and diagnostic tests.

Module Name | Module Description

SEATERM For awide variety of instruments:

e SBE 11/11plus CTD Deck Unit

e SBE 16 SEACAT C-T Recorder

e SBE 16plus SEACAT C-T Recorder

* SBE 17 SEARAM

e SBE 19 SEACAT Profiler

e SBE 19plus SEACAT Profiler

e SBE 21 SEACAT Thermosalinograph

* SBE 25 SEALOGGER CTD

e SBE 35 Thermometer

e SBE 37 MicroCAT

e SBE 38 Digital Oceanographic Thermometer
e SBE 39 Temperature (optional pressure) Recorder
e SBE 44 Underwater Inductive Modem

e SBE 45 Thermosalinograph

e SBE 48 Hull Temperature Sensor

Seater mAF For instruments that power and operate water samplers
without real-time communication to the surface:

e SBE 17plusV2 SEARAM

¢ SBE 90208 Carousel Auto Fire Module

(used independently or with SBE 19, 19plus, or 25)
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Section 4: Terminal Program Modules

General Description

Note:
Once the system is configured and
connected (see Getting Started
below), to update the Status bar:
« on the Toolbar, click Status; or
« from the Utilities menu, select
Instrument Status.
The program sends the status
command, which displays in the
Command/Data Echo Area, and
updates the Status bar.

Double click on the SEATERM icon. SEATERM'’s main screen looks like this
(SeatermAF is similar):

Note:
There is at least one, and as many

as three ways, to enter a command:

* Manually type command in
Command/Data Echo Area

« Use a menu to automatically
generate a command

» Use a Toolbar button to
automatically generate
a command

5 :| h.. .. [um ‘e i \/ enus IR
1“~.|l “-_|I|IJ l|l z«?|=| |
s Cwms I, pia ] 1 Sy [
Toolbar
Command/Data Echo Area
Status bar
Computer Upload Capture to file status —
Instrument COM port type grayed out if not capturing
- 4] a1 Ced Eaiin o | o

A A

Instrument EPROM version Baud rate, data bits, stop bits, and parity

*  Menus— Contains tasks and frequently executed instrument commands.

*  Toolbar — Contains buttons for frequently executed tasks and instrument
commands. All tasks and commands accessed through the Toolbar are
also available in the Menus. To display or hide the Toolbar, select View
Toolbar in the View menu.

e Command/Data Echo Area— Echoes a command executed using a Menu
or Toolbar button, as well as the instrument’ s response. Additionally, a
command can be manually typed in this area, from the available
commands for the instrument. Note that the instrument must be awake for
it to respond to a command (use the Connect button on the Toolbar to
wake up the instrument).

»  Status bar — Provides status information. To display or hide the Status bar,
select View Status Bar in the View menu.

Note that Menus and Toolbar buttons that are not applicable to the selected

instrument are grayed out and cannot be selected.
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Getting Started

Note: Follow these steps to get started using SEATERM (SeatermAF is similar) with
All Sea-Bird instruments have a your instrument:

timeout feature. After a period of

time without communication, the . . .
instrument and computer 1. Inthe Configure menu, select the instrument. Enter the COM settings for

disconnect. the instrument enters your instrument in the Configuration Options dialog box.
a quiescent (sleep) state, and the SBE 45 Configurafion Opfions
command/data echo area .

indicates time out. You must COM Sesi Instrument EPROM version — may
reconnect to the instrument g affect available upload baud rate

before sending any commands.

EFFOM Yemsion

Interface for communication
between computer and
instrument

L0 e

Computer COM port, baud rate,

data bits, and parity for %ﬂ /
communication between computer MM Por®™Boud Rt Mods

and instrument

[ =l =0 = & RE-23 (Ful Dupley)
T FE-35 (Helf Duglex)
Cintn By T Inductiee Moder | Not applicable if
4] & L Mode is RS-232.
¢ Prompt ID
Muodzm/F:S4851D if multiple
instruments
L on-line.
B i * Mana R * Automatically
get ID if
1 instrument
on-line.

Cancel Dieleuk | Help | CiE, |

Click OK to overwrite an existing configuration file, or click Save Asto
save the configuration as a new file name.

2. Click the Connect button on the Toolbar. The system should respond with
adialog box stating ‘ Connected successfully . .. and an S> prompt. If it
does not:

*  Try to establish communications again.

*  Check cabling between the computer and instrument.

*  Verify the correct instrument was selected and the COM Settings
were entered correctly in the Configure Menu.

3. Enter commands using one of these methods:
*  Manually typein the command in the Command/Data Echo Area,
* Useamenu to automatically generate a command (applicable to
frequently used commands), or
* Useatoolbar button to automatically generate acommand (applicable
to frequently used commands).
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SEATERM

SEATERM is used to interface with the following instruments:
e SBE 11/11plus CTD Deck Unit

* SBE 16 SEACAT C-T Recorder

*  SBE 16plus SEACAT C-T Recorder

* SBE 17 SEARAM

*  SBE 19 SEACAT Profiler

e SBE 19plus SEACAT Profiler

* SBE 21 SEACAT Thermosalinograph

* SBE 25 SEALOGGER CTD

*  SBE 35 Thermometer

e SBE 37 MicroCAT

*  SBE 39 Temperature (optional Recorder
e SBE 45 MicroT SG Thermosalinograph
*  SBE 48 Hull Temperature Sensor

Following isabrief discussion of the Toolbar Key functions.

Toolbar
Keys

Description

Equivalent
Command *

Connect

Re-establish communications with instrument. Computer
responds with S> prompt.

(press Enter
key)

Status

Digplay instrument status.

DS

Headers

View data headers. New data header is generated for:

. each cast for profiling instruments —-SBE 17,
19 (profiling mode), and 25

* each datablock in moored instruments— SBE 16, 19
(moored mode), and 21. New header is written when
logging starts/resumes, sample interval changes, or
specified number of samples have been recorded since
last header was written.

DH

Coeff

Display calibration coefficients for products with internally
stored coefficients — SBE 35, 37, 39, 45, and 48.

DC

Init Log

Initialize datalogging for SBE 16, 17, 19, 21, and 25, to
reset data pointers and cast number. Do this after existing
data has been uploaded from instrument and prior to
recording new data.

Capture

Capture all information received by computer serial port to
file, to collect real-time data/diagnostic information. File
has .CAP extension. Press Capture again to turn off capture.
Capture status displays in Status bar. For instrumentswith
no internal memory (SBE 37-Sl or 45), must capture
before sampling beginsto save the data for future
review and processing.

Upload

Retrieve data stored in instrument’ s memory. Note that you
must stop logging befor e uploading data.

DD or DC

Convert

Convert uploaded ASCII data from SBE 37-IM or

37-SM to .cnv file format before processing data with

SBE Data Processing. Soon to be available for SBE 39 -
use CNV39 in SEASOFT-DOS if Convert button is grayed
out for SBE 39.

Diagnostics

Perform one or more diagnostic tests. Diagnostic test(s)
accessed in this manner are non-destructive —they do not
write over existing instrument settings or data.

(dependent
on
instrument)

Stop

Interrupt and end current activity, such as: logging,
uploading, or diagnostic testing.

Disconnect

Free computer COM port used to communicate with
instrument. COM port can then be used by another
program. Any logging in progress will continue after COM
port is disconnected if instrument has internal memory.
Instruments with no internal memory (SBE 37-Sl or 45)
must be connected to COM port for data to be obtained.

*See command descriptionsin instrument User’s Manual.
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SeatermAF

SeatermAF is used to interface with instruments that power and operate

water samplers without real-time communication to the surface:

* SBE 17plusV2 SEARAM

e SBE 90208 Carousel Auto Fire Module (AFM) used with SBE 19, 19plus,
or 25 CTD, or withno CTD

Following isabrief discussion of the Toolbar Key functions.

Toolbar Description Equivalent

Keys Command *

Connect Re-establish communications with SBE 17plusV2. | (press Enter key)
Computer responds with S> prompt.

Connect Re-establish communications with SBE 19, 19plus, |-

CTD or 25 CTD. Computer responds with S> prompt.

Connect Re-establish communications with AFM. Computer |-

AFM responds with A> prompt.

Status Display instrument status - provide informationon  |DS
instrument setup and current status.

Headers View data headers (cast number, date and time, DH
number of samplesin cast, and sampleinterval).

A new header is generated for each cast (applicable
to SBE 17plus V2, 19, 19plus, and 25)

Closure Display auto fire parameters and auto fire status CP

Parameters | (applicable to SBE 17plus V2 and AFM)

AFM

Init Log Initialize datalogging for SBE 17plusV2, 19, 19plus,|IL (19 and 25)
and 25, to reset data pointers and cast number. Do INITLOGGING
this after existing data has been uploaded from (29plus)
instrument and prior to recording new data. SAMPLENUM=0

(17plusV2)

Capture Capture all information received by computer serial | —
port to file, to collect real-time data/diagnostic
information. File has .cap extension. Press Capture
again to turn off capture. Capture status displaysin
Status bar.

Upload Retrieve data stored in instrument’s memory. Note | (dependent on
that you must stop logging before uploading data. |instrument)

Program Send auto fireinformation input in Configure menu | -
to AFM or SBE 17plus V2. Must send this
information before deployment for auto fire
capability to function.

Arm Enable auto fire algorithm to close bottles. Must arm |ARM
AFM of SBE 17plus V2 before deployment for auto
fire capability to function.

Diag Perform one or more diagnostic tests. (dependent on
Diagnostic tests accessed in this manner are instrument)
non-destructive - they do not write over any existing
instrument settings.

Stop Interrupt and end current activity, such as: logging, |—
uploading, or diagnostic testing.

Disconnect |Free computer COM port used to communicate with |—
instrument. COM port can then be used by another
program. Any logging in progress will continue after
COM port is disconnected.
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Section 5: Configuring the Instrument
(CONFIGURE)

Module Name Module Description

CONFIGURE Define instrument configuration and calibration
(equivalent to coefficients.

SEACON in
SEASOFT-DOS)

Introduction
CONFIGURE creates or modifies a configuration (.con) file to define the

Notes:

1. Sea-Bird supplies a .con file with
each instrument. The .con file
must match the existing
instrument configuration and
contain current sensor
calibration information.

2. An existing .con file can be
modified in CONFIGURE, or in
the DATA CONVERSION,
DERIVE, or ROSETTE
SUMMARY post-processing
module.

3. Appendix Il: Configure (.con) File
Format contains a line-by-line
description of the contents of the
.con file.

4. An SBE 35, 37, 39, and 48 stores
calibration coefficients internally,
and does not have a .con file.

instrument configuration and sensor calibration coefficients. CONFIGURE is
applicable to the following instruments:

SBE 9plus with SBE 11plus Deck Unit or SBE 17plus SEARAM
(SBE 9plusislisted as the 911/917plus in the Configure menu)
SBE 16

SBE 16plus

SBE 19

SBE 19plus

SBE 21

SBE 25

The discussion of CONFIGURE isin three parts.

Instrument Configuration covers the Configuration dialog box - number
and type of sensors on the instrument, etc. - for each of the instruments
listed above.

Calibration Coefficients for Frequency Sensors covers calculation of
coefficients for each type of frequency sensor (temperature, conductivity,
Digiquartz pressure, IOW sound velocity, etc.).

Calibration Coefficients for Voltage Sensors covers calculation of
coefficients for each type of voltage sensor (strain gauge pressure,
oxygen, pH, etc.).

Access CONFIGURE by selecting the desired instrument in the Configure
menu in the SBE Data Processing window.

Before selecting the instrument, review the status of Confirm
Configuration Change in the Configure menu. If Confirm Configuration
Change is selected, program provides a prompt to save the configuration
(.con) fileif you make changes and then click the Exit button in the
Configuration dialog box without clicking Save or Save As. If not
selected, program changes Exit button to Save & Exit; to exit without
saving changes, use the Cancel button.

Il

BZ SBE Data Processing Hi=] E3
Burr | Configws  Help
1 16 Seacat CTO..
2 16 Seacat plus CTD..
3. 1958acat CTD...
4. 19 5eacat plus CTD...
5, 21 Themosalinagraph...
£, 25 Sealogger CTO,..
7 9114317 plus CTLL.

|l Confirm Configuration Ehange
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Instrument Configuration

Channel/Sensor table reflects

this choice.

* 0 (SBE 3 or 4 plugged into
COND 2 on SBE 9plus
end cap — dual redundant
sensor configuration)

¢ 1 (SBE 3 or 4 plugged into
TEMP 2 on SBE 9plus end
cap and not using COND 2
connector — single redundant
sensor configuration)

e 2 (no redundant T or C sensors)

For full rate data, set to 1.
Example: CTD scan rate 24 Hz and
number of scans to average 24,
effective scan rate = 24/24 =

1 scan/second.

» Surface PAR - Select if
SBE 11plus has surface PAR
option installed and SBE 11plus
microprocessor PCB DIP switch
S3 position 8 is set to Off.
Selecting Surface PAR voltage
adds 2 channels to
Channel/Sensor table.

* NMEA - Select if NMEA interface
option installed in SBE 11plus and
connected to NMEA interface. If
selected, SEASAVE automatically
adds current latitude, longitude,
and universal time code to data
header. Select NMEA (Lat/Lon)
Interface in SEASAVE'’s Configure
menu to control how Lat/Lon data
is incorporated.

SBE 9plus Instrument Configuration

The SBE 9plusis configured for twelve 24-bit words of data sampled at

24 scans per second. The pressure sensor is a high-resolution Paroscientific
digiquartz with temperature compensation. An optional full-duplex modem
channel permitsindependent control of a water sampler or other instruments.
Firmware in the SBE 11plus Deck Unit permits the suppression of unused

data channels.

Configuration for the SBE 911/917 plus CTD Y&

LSS file opened: None

Frequericy channels to suppress |-| 7i

I
m/ IEEE-488 (GPIB) or RS-232C, based on

Woltage words to suppress
Computer nterface
Stang to average

- -:Surfat:a P&R: voltage added

Channel/Sensor table reflects this choice.
Total number of voltage words is 4, and each
word contains data from two 12-bit A/D
channels. SBE 11plus suppresses words
starting with highest numbered word. Number
of words to keep is determined by highest
numbered external voltage input that is not a
spare:

Words to suppress =4 - Words to Keep

External Voltage Connector Words to Keep

(not spare)

AUX 1 1
20r3 AUX 2 2
4or5 AUX 3 3
6or7 AUX 4 4

how SBE 11plus is connected to computer.

Select to include time of each scan with data.

[ Seantime added |

™ MMEA position dats added Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.
e | e
g - { — HE / | Hew [New to create new
1. Frequenci D | Temperature / Hger | -con file for this CTD.

2 Frequency 1 | Eonductivity i Open to select

3 Frequency 2 | Pressure, Digiquartz with TS &y | different .con file.

4 Frequeneyd | Sound Velosity, 10w/ Save or Save As (o
g rinieiels - S ave Adsave current .con file
?VDEED—I Prassir. FGP settings.

B Walkage 1 | Ompgen, SBE

7. Walkage 2 | Fluorometer, Biosphencal Natural
B Voltage 3 | Ailtirneter

Click a (non-shaded) sensor and click Select to pick a
different sensor for that channel. A dialog box with a list of
|sensors appears. Select sensors after number of frequency

Click a sensor and click
Modify to change calibration
coefficients for that sensor.

Opens a .txt file (for viewing
and printing only; cannot be
modified) that shows all
parameters in .con file.

Repart... Help:.

-{channels and voltage words have been specified above.

Caricel

/E:-:it I

[

Return to SBE Data Processing window.

« If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to

save changes.

« If Confirm Configuration Change was not selected
in Configure menu - This button says Save & Exit.
If you do not want to save changes, use Cancel

button to exit.
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SBE 16 SEACAT C-T Recorder Instrument Configuration

Select strain gauge, Digiquartz with or
without temperature compensation, or no
pressure sensor. If no pressure sensor or

Configuration for the SBE 16 Seacat CTD Digiquartz without Temp Comp is selected,
the Data button accesses a dialog box to

ey ;i input additional parameter(s) needed to
A5CI fite opened; None process data.

Channel/Sensor table reflects this

choice (0, 1, 2, 3, or 4). Must agree Pressure sensor ype Mo Pressure Sensor »| Data. I
with number programmed into SBE 16; | _I

see configuration sheet or reply from | — Esternal valtage chaninels [E_Ei

status command (DS). See SBE 16 configuration sheet

Time between scans. strain gauge pressure sensor

o o ror reply from status command
}\ Firmwiare vetsior I‘Jersian wedfl e 1/ (DS). Used to determine

Sample wteral seconds |1 5 data format. |

NMEA - Select if connected to
optional NMEA interface (SBE 90158 ~~0" NMEA nosition data added Shaded sensors cannot be removed or changed to
NMEA nterface box with GPS or 5 A another type of sensor. All otherslare optional.
LORAN receiver). If selected, . / - o
SEASAVE automatically adds current Chaninel SEnsor | New [New to create new
latitude, longitude, and universal time 1. Frequehcy 0 Temperature / 0 .con file for this CTD.
—_— e R L. [ I' 2 e'-n'...
code to data heade_r. Select NMI’EA 2 Fienushcilt Carductivity pe Qpen to selec@
(Lat/Lon) Interface in SEASAVE's bl i different .con file.
Configure menu to control how 3 Maltage 0 | &ltirneter “a/e |Save or Save As to
Lat/Lon data is incorporated. 1 \-’Eult@-gﬂ Owygen; SBE — 22;ien;§rrent .con file
Click a (non-shaded) sensor and click Select : :
to pick a different sensor for that channel. A
dialog box with a list of sensors appears. Click a sensor
Select sensors after number of voltage and click Modify
channels have been specified above. to change
calibration
o ot file (for viewi — - - coefficients for
pens a .txt file (or viewing Reparl... l Help.. | Exit I Caniel | that sensor.
and printing only; cannot be : :
modified). that shows all

parameters in .con file.

Return to SBE Data Processing window.

« If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

« If Confirm Configuration Change was not selected
in Configure menu - This button says Save & Exit.
If you do not want to save changes, use Cancel
button to exit.
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SBE 16plus SEACAT C-T Recorder
Instrument Configuration

Select strain gauge, Digiquartz with or
without temperature compensation, or no
pressure sensor. If no pressure sensor or

2 < Digiquartz without Temp Comp is selected,
Configuration for the SBE 16 Seacat plus CTD the Data button accesses a dialog box to

.ﬁ:SEII fﬂﬁpp?ﬁed? Nore input additional parameter(s) needed to

Channel/Sensor table reflects this
choice (0, 1, 2, 3, or 4). Must agree
with number programmed into

SBE 16plus; see configuration sheet or
reply from status command (DS).

process data.

Fressure sensor type |N|:| Fressure Sesar _ﬂ Data... |

SBE 16plus is intended for

Moored mode - interval between

scans when logging data. —Sample interval secands |1 n

Select if connected to optional NMEA
interface (SBE 90158 NMEA nterface
box with GPS or LORAN receiver). If
selected, SEASAVE automatically
adds current latitude, longitude, and
universal time code to data header.
Select NMEA (Lat/Lon) Interface

in SEASAVE's Configure menu

to control how Lat/Lon data is
incorporated.

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

HE«terhal voltage chahnels I4 vi Select SBE 38 if connected to
|optional secondary temperature
Sienal R5-2320 sensar / sensor. See SBE 16plus
: Zeen |N':'”E = configuration sheet or reply from
use in Moored mode. \M : status command (DS).
ode |Mnnred Ti

Stan: io average | 7

| T MMES posiion data added Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.

_____Ehannle;l__l__________ il /| Mew New to create new
| Frequency0 | Temperatire G| con file for this CTD.
2. Frequency 1 | Eonductivity JoS Open to select
_ = different .con file.
3 VolageQ | Fres “"F _|save or Save As to
4. Malage 1 Free e current .con file
o D = |settings.
5 Molkage 2 | Click a (non-shaded) sensor and click Select 9

B. Waltage 3 |to pick a different sensor for that channel. A
= [dialog box with a list of sensors appears.
Select sensors after number of voltage
channels have been specified above.

Click a sensor
and click Modify
to change
calibration

Repart... Help... Esit l Connal I coefficients for

that sensor.

Return to SBE Data Processing window.

« If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

« If Confirm Configuration Change was not selected
in Configure menu - This button says Save & Exit.
If you do not want to save changes, use Cancel
button to exit.
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SBE 19 SEACAT Profiler Instrument Configuration

Configuration for the:5BE 19 Seacat CTD

Select strain gauge or

Channel/Sensor table reflects this ASCI file opened: Nane Digiquartz with temperature compensation

choice (0, 2, or 4). Must agree with
number programmed into SBE 19; see
configuration sheet or reply from status | T IES8HIE SErE0r type IStrain Gauge :i
command (DS). \E

Pressure voltage is always last in table. sternal voltage chatnels !2 vl

See SBE 19 configuration sheet

' Firmiare vetsion Version =30 = or reply from status command
Used to compute time

ber | (DS). Used to determine
etween samples. 05 zecond interdalz 11 strain gauge pressure sensor
data format.

[ Suface PAR voltage added |

» Surface PAR - Select if surface
PAR voltage added by NMEA ; Shaded sensors cannot be removed or changed to
i i [ MMEA position data-addsd another type of sensor. All others are optional.
interface. Selecting Surface PAR p
voltage adds 2 channels to — — / 1
Channel/Sensor table. Chanrel ! Senzor | fle|New to create new

« NMEA - Select if connected to 1. Frequency | Temperaliie / 80” f||te forlth'f CTD.
optional NMEA interface (SBE 2 I:_r—'l_| Bt Dper Open to select
90158 NMEA nterface box with - FIEqUency it ¥ different .con file.
GPS or LORAN receiver). If 3 Waltage 0 [ pH Gyl Save or Save As to
selected, SEASAVE automatically 4, Vicltage 1 [ T rarrasomalar Erele s st A St = save current .con file
adds current latitude, longitude, ] - . - S ave | settings.
and universal time code to data B Prezau Cllcl_( a (nqn—shaded) sensor and click Select
header. Select NMEA (Lat/Lon) ~ |to pick a different sensor for that channel. A

Click a sensor
—_—and click Modify
to change
calibration
coefficients for
that sensor.

Interface in SEASAVE's Configure _ l|dialog box with a list of sensors appears.
menu to control how Lat/Lon data Select sensors after number of voltage

is incorporated channels have been specified above.

Opens a .txt file (for viewing
and printing only; cannot be | _~ b I {e I P Caaal I
modified). that shows all B Help... gt ance |
parameters in .con file.

Return to SBE Data Processing window.

« If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

« If Confirm Configuration Change was not selected
in Configure menu - This button says Save & Exit.
If you do not want to save changes, use Cancel
button to exit.
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SBE 19plus SEACAT Profiler Instrument Configuration

Configuration for the:5BE 19 Seacat plus CTD

Channel/Sensor table reflects this
choice (0, 1, 2, 3, or 4). Must agree
with number programmed into

SBE 19plus; see configuration sheet or

reply from status command (DS).

ASCIl file opered: Nore

Prezzure sensar type

Select strain gauge or
Digiquartz with temperature compensation

| Shain Gauge

Esternal voltage channels i4 _i

Moored mode - interval between
scans when logging data.

tode

Select Profiling or Moored mode.

\Erample'irﬂerval geconds: [

Profiling mode - number of samples
to average (samples at 4 Hz).

\S_cem o average

e Surface PAR - Select if surface

—

A~ Surlace PAR vollage added

7

Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.

PAR voltage added by NMEA
interface. Selecting Surface PAR
voltage adds 2 channels to
Channel/Sensor table.

NMEA - Select if connected to
optional NMEA interface (SBE
90158 NMEA nterface box with
GPS or LORAN receiver). If
selected, SEASAVE automatically
adds current latitude, longitude,
and universal time code to data
header. Select NMEA (Lat/Lon)
Interface in SEASAVE'’s Configure
menu to control how Lat/Lon data
is incorporated.

\f" NMEA positioh data added

Chiarnel | Senaar / Mew |New to create new

- = 7 .con file for this CTD.
(L Frequencyl Temper.ature fipen . |Open to select
2 Frequercy 1 Canduictivib — - \different .con file.
&8 = ; = Save or Save As to
3. Frequency 2 Erassura, Strain Gauge iy cave current con file
; ree i
4 Voltage 0 _ e settings.

5. Waltag| Click a (non-shaded) sensor and click Select

E:._ Valag to pick a different sensor for that channel. A

dialog box with a list of sensors appears.

. Wakagl select sensors after number of voltage

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

L~ Fepol...

channels have been specified above.

Hglp...

Click a sensor
and click Modify
to change
calibration
coefficients for
that sensor.

Return to SBE Data Processing window.

« If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

« If Confirm Configuration Change was not selected
in Configure menu - This button says Save & Exit.
If you do not want to save changes, use Cancel
button to exit.
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Channel/Sensor table reflects
this choice (0 or 1). Must agree
with number programmed into
SBE 21; see configuration
sheet or reply from status
command (DS).

Time between scans.

NMEA - Select if connected to
optional NMEA interface (SBE
90158 NMEA nterface box with
GPS or LORAN receiver). If
selected, SEASAVE
automatically adds current
latitude, longitude, and
universal time code to data
header. Select NMEA (Lat/Lon)
Interface in SEASAVE's
Configure menu to control how
Lat/Lon data is incorporated.

Exterral frequercy channels | 1 - I

External voltage chatinels |1 a’

™ Sample interval secands

| NMEA position data added

SBE 21 Thermosalinograph Instrument Configuration

Configuration for the SBE 21 Thermoszalinograph

ASEIl file cpened: None

Channel/Sensor table reflects this
choice (0, 1, 2, 3, or 4). Must agree
with number programmed into
SBE 21, see configuration sheet or
reply from status command (DS).

—

E|

Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.

/

New to create new

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

Hepan.l Help... I

Click a (non-shaded) sensor and click Select
to pick a different sensor for that channel.

A dialog box with a list of sensors appears.
Select sensors after number of voltage

and frequency channels have been

specified above.

Exit

Chanriel |_ - Sensar | Mew
1. Frequency 0 iTemperatwa / =
e = [
2 Frequericy 1 IEDt‘IdUEtI'-.-‘It_',' j RS
3 Frequency 2 | Temperature, 2 B
4. Wolkage 0 pH e

.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file
settings.

Click a sensor
and click Modify
to change
calibration
coefficients for
that sensor.

Return to SBE Data Processing window.

If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

If Confirm Configuration Change was not selected

in Configure menu - This button says Save & Exit.

If you do not want to save changes, use Cancel
button to exit.
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SBE 25 SEALOGGER Instrument Configuration

Configuration for the SEE 25 Sealogges CTD

Used to determine .hex data format.
See configuration sheet or reply from
status command (DS).

« Surface PAR - Select if using
optional SBE 33 Carousel Deck Unit
or SBE 36 CTD Deck Unit to append
Surface PAR data to each scan.
Selecting Surface PAR voltage adds
2 channels to Channel/Sensor table.

* NMEA - Select if using optional
SBE 33 Carousel Deck Unit or
SBE 36 CTD Deck Unit to append
NMEA position data. SEASAVE
automatically adds current latitude,
longitude, and universal time code to
data header. Select NMEA (Lat/Lon)
Interface in SEASAVE's Configure
menu to control how Lat/Lon data
is incorporated.

<

Opens a .txt file (for viewing
and printing only; cannot be
modified). that shows all
parameters in .con file.

ASCH Hs openad: Mons
Eueinal volage charrels
™ Fisreraie warsion

Figead baver darla codpud 1adn |I scan/sec ""l’

[T Surfsce PAR wokage added
[T HMEA posison dats sdded

Channel/Sensor table reflects thioice (0-7). Must
agree with number programmed into SBE 25; see
configuration sheet or reply from status command (DS).

|-.'r'1=|.'|-'| =20 |

1, 2, 4, or 8 scans/second. Used to calculate
elapsed time while acquiring real-time data.

Shaded sensors cannot be removed or changed to
another type of sensor. All others are optional.

Channel Serm
1. Freguancy 0 | Tsmpessturs
2 Freguency 1 Comnduciialy
1 Fiesoue volage :Prnﬁ-ur!_ S Gawge
4 Wolage 1 Oudsion Feduction Polenisl
5 Volaga? | A

Click a (non-shaded) sensor and click Select
to pick a different sensor for that channel.

A dialog box with a list of sensors appears.
Select sensors after number of voltage
channels have been specified above.

\th-m||4ﬂ=-|

Mew

Open

Save b

/: _Click a sensor

New to create new
.con file for this CTD.
Open to select
different .con file.
Save or Save As to
save current .con file

settings.

and click Modify
to change
calibration
coefficients for
that sensor.

Return to SBE Data Processing window.

If Confirm Configuration Change was selected in
Configure menu - If you made changes and did
not Save or Save As, program asks if you want to
save changes.

If Confirm Configuration Change was not selected

in Configure menu - This button says Save & Exit.

If you do not want to save changes, use Cancel
button to exit.
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Calibration Coefficients for Frequency Sensors

Notes:

1. Coefficients g, h, i, j, and fO
provide ITS-90 (T,)
temperature; a, b, c, d, and fO
provide IPTS-68 (T,,)
temperature. The relationship
between them is:

T, =1.00024 T

2. See Application Note 31 for
computation of slope and
offset correction coefficients
from pre- and post-cruise
calibrations supplied by
Sea-Bird.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box.
For all calibration dialog boxes, enter the sensor serial number and calibration
date. Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor.
Temperature, conductivity, and Digiquartz pressure sensors are covered first,
followed by the remaining frequency sensor typesin alphabetical order.

Temperature Calibration Coefficients
Enter g, h, i, j (or a b, ¢, d), and fO from the calibration sheet.
Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for temperature sensor drift between calibrations:
Corrected temperature = (dope * computed temperature) + offset
where
dope = true temperature span / instrument temperature span
offset = (true temperature — instrument reading) * slope; measured at 0 °C

Temperature Sope and Offset Correction Example

At true temperature = 0.0 °C, instrument reading = 0.0015 °C
At true temperature = 25.0 °C, instrument reading = 25.0005 °C
Calculating the slope and offset:

Slope = (25.0 - 0.0) / (25.0005 — 0.0015) = + 1.000040002
Offset = (0.0 — 0.0015) * 1.000040002 = - 0.001500060

Sea-Bird temperature sensors usually drift by changing offset, typically
resulting in higher temperature readings over time for sensors with serial
number less than 1050 and lower temperature readings over time for sensors
with serial number greater than 1050. Sea-Bird’s data indicates that the drift is
smooth and uniform with time, allowing users to make very accurate
corrections based only on pre- and post-cruise laboratory calibrations.
Calibration checks at sea are advisable to ensure against sensor malfunction;
however, data from reversing thermometersis rarely accurate enough to make
calibration corrections that are better than those possible from shore-based
laboratory calibrations.

Sea-Bird temperature sensors rarely exhibit span errors larger than + 0.005 °C
over the range -5 to +35 °C (0.005 °C/(35 -[-5])C/year = 0.000125 °C/Clyear),
even after years of drift. A span error that increases more than

+ 0.0002 °C/Clyear may be a symptom of sensor malfunction.
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Note:

Use coefficients g, h, i, j, Ctcor,
and Cpcor (if available on
calibration sheet) for most
accurate results; conductivity for
older sensors was calculated

based on a, b, ¢, d, m, and Cpcor.

Note:

See Application Note 31 for
computation of slope and offset
correction coefficients from pre-
and post-cruise calibrations
supplied by Sea-Bird or from
salinity bottle samples taken at
sea during profiling.

Conductivity Calibration Coefficients

Enter g, h, i, j, Ctcor (or a, b, ¢, d, m) and Cpcor from the calibration sheet.

*  Cpcor makes a correction for the highly consistent change in dimensions
of the conductivity cell under pressure. The default is the compressibility
coefficient for borosilicate glass (-9.57e-08). Some sensors fabricated
between 1992 and 1995 (serial numbers between 1100 and 1500) exhibit a
compression that is dightly less than pure borosilicate glass. For these
sensors, the (hermetic) epoxy jacket on the glass cell is unintentionally
strong, creating a composite pressure effect of borosilicate and epoxy.

For sensors tested to date, this composite pressure coefficient ranges from
-9.57e-08 to -6.90e-08, with the latter value producing a correction to
deep ocean salinity of 0.0057 PSU in 5000 dbars pressure (approximately
0.001 PSU per 1000 dbars).

Before modifying Cpcor, confirm that the sensor behaves differently from
pure borosilicate glass. Sea-Bird can test your cell and calculate Cpcor.
Alternatively, test the cell by comparing computed salinity to the salinity
of water samples from arange of depths, calculated using an AutoSal.

Enter values for slope (default = 1.0) and offset (default = 0.0) to make small
corrections for conductivity sensor drift between calibrations:

Corrected conductivity = (slope * computed conductivity) + offset

where

dlope = true conductivity span / instrument conductivity span

offset = (true conductivity — instrument reading) * slope; measured at 0 S/m

Conductivity Sope and Offset Correction Example

At true conductivity = 0.0 S/m, instrument reading = -0.00007 S/m
At true conductivity = 3.5 S/m, instrument reading = 3.49965 S/m
Calculating the slope and offset:

Slope = (3.5-0.0) / (3.49965 - [- 0.00007]) = + 1.000080006
Offset = (0.0 - [-0.00007]) * 1.000080006 = + 0.000070006

The sensor usually drifts by changing span (slope of the calibration curve),
typically resulting in lower conductivity readings over time. Offset error
(error at 0 S/m) is usually due to electronics drift, and istypically less than
+ 0.0001 S/m per year. Because offsets greater than + 0.0002 S/m are a
symptom of sensor malfunction, Sea-Bird recommends that drift corrections
be made by assuming no offset error, unlessthereis strong evidence to the
contrary or a special need.

Wide Range Conductivity Sensors

A wide range conductivity sensor has been modified to provide conductivity
readingsto 15 Siemens/meter by inserting a precision resistor in series with
the conductivity cell. Therefore, the equation used to fit the calibration datais
different from the standard equation. The sensor’ s High Range Conductivity
Calibration sheet includes the equation as well as the cell constant and series
resistance to be entered in the program.

If the conductivity sensor serial number includesaw (an indication that it isa

wide range sensor):

1. After you enter the calibration coefficients and click OK, the Wide Range
Conductivity dialog box appears.

2. Enter the cell constant and series resistance (from the High Range
Conductivity Calibration sheet) in the dialog box, and click OK.
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Pressure (Paroscientific Digiquartz) Calibration Coefficients

Note: Enter the setsof C, D, and T coefficients from the calibration sheet. Enter zero
See Calibration Coefficients for for any higher-order coefficients that are not listed on the calibration sheet.
Voltage Sensors below for Enter values for slope (default = 1.0; do not change unless sensor has been
information on strain gauge recalibrated) and offset (default = 0.0) to make small corrections for

pressure sensors. sensor drlft

e For the SBE 9plus, also enter AD590M and AD590B coefficients from
the configuration sheet.

Bottles Closed (HB - IOW) Calibration Coefficients

No calibration coefficients are entered for this parameter.

The number of bottles closed is calculated by DATA CONVERSION
based on frequency range.

Sound Velocity (IOW) Calibration Coefficients
Enter coefficients a0, al, and a2.
Value= a0 + al * frequency + a2 * frequency
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Calibration Coefficients for Voltage Sensors

Note:

See Calibration Coefficients for
Frequency Sensors above for
information on Paroscientific
Digiquartz pressure sensors.

Note:

Enter the altimeter alarm set
point, alarm hysteresis, and
minimum pressure to enable
alarm in SEASAVE.

View and/or modify the sensor calibration coefficients by selecting the sensor
and clicking the Modify button in the instrument Configuration dialog box.
For all calibration dialog boxes, enter the sensor serial number and calibration
date. Many sensor calibration equations contain an offset term. Unless noted
otherwise, use the offset (default = 0.0) to make small corrections for sensor
drift between calibrations.

Calibration coefficients are discussed below for each type of sensor. Strain
gauge pressure sensors are covered first, followed by the remaining voltage
sensor types in alphabetical order.

Pressure (Strain Gauge) Calibration Coefficients
Enter coefficients:
*  Pressure sensor without temperature compensation

> Enter AO, A1, and A2 coefficients from the calibration sheet

» For older units with alinear fit pressure calibration, enter M (A1) and
B (A0Q) from the calibration sheet, and set A2 to zero.

»  For al units, offset is normally zero, but may be changed for non-
zero sea-surface condition. For example, if thein-air pressure reading
is negative, enter an equal positive value.

*  Pressure sensor with temperature compensation

Enter ptempAO, ptempAl, ptempA2, pTCAO, pTCAL, pTCA2, pTCBO,

pTCB1, pTCB2, pAO, pAl, and pA2 from the calibration sheet.

Altimeter Calibration Coefficients

Enter the scale factor and offset.

altimeter height = [300 * voltage / scale factor] + offset

where

scale factor = full scale voltage * 300/full scale range

full scale range is dependent on the sensor (e.g., 50m, 100m, etc.)
full scale voltage is from calibration sheet (typically 5V)

Fluorometer Calibration Coefficients
» Biospherical Natural Fluorometer
Enter Cfn (natural fluorescence calibration coefficient), A1, A2, and B
from calibration sheet.
natural fluorescence Fn = Cfn* 10Y
production=Al1* Fn/ (A2 + PAR)
chlorophyll concentration Chl = Fn/ (B * PAR)
where
V isvoltage from natural fluorescence sensor
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Chelsea Aquatracka

Enter VB, V1, Vacetone, slope, offset, and SF.

Concentration (ug/l) = slope*[(10.0(V/SF) - 10.0VB)/(10.0V1 - 10.QVacetone))
+ offset

where

VB, V1, and Vacetone are from calibration sheet

Slope (default 1.0) and offset (default 0.0) adjust readings to conform to

measured concentrations

Scalefactor SF=1.0if CTD gainis1; SF=2if CTD gainis2.0

V is output voltage measured by CTD

Chelsea Aquatracka Example - Calculation of Sope and Offset
Current slope = 1.0 and offset = 0.0
Two in-situ samples:
Sample 1 —
Concentration (from SBE Data Processing) = 0.390
Concentration (from water sample) = 0.450
Sample 2 —
Concentration (from SBE Data Processing) = 0.028
Concentration (from water sample) = 0.020
Linear regression to this datayields dope = 1.188 and offset = - 0.013

Chelsea Minitracka
Enter Vacetone, Vacetonel00, and offset.
Concentration = (100 *[V - Vacetone]/[V acetonel00 - Vacetone]) + offset
where
Vacetone (voltage with 0 ug/l chlorophyll) and Vacetonel00 (voltage
with 100 pg/l chlorophyll) are from calibration sheet
Dr Haardt Fluorometer - Chlorophyll a, Phycoerythrin, or
Yellow Substance
Enter AO, A1, BO, and B1.
These instruments may have automatic switching between high and low
gains. Select the gain range switch:
» Output Voltage Level if the instrument indicates gain by output
voltage level (< 2.5 voltsislow gain, > 2.5 voltsis high gain)
Low gain: vaue=A0+ (Al* V)
Highgain: value=B0O+ (B1* V)
» Modulo Bit if the instrument has control lines custom-wired to bitsin
the SBE 9plus modulo word
Bit set: value=A0+ (A1* V)
Bit not set: value=B0 + (B1* V)
» Noneif the instrument does not change gain
vaue=A0+ (Al* V)
where
V = voltage from sensor

Dr Haardt Voltage Level Switching Examples

Example: Chlorophyll a

Lowrangescade=10mg/l and Gain=10/2.5=4 mg/l/volt
A0=0.0 Al=40

Highrangescale=100mg/l and Gain= 100/2.5 =40 mg/l/volt

BO=-100 B1=40.0
Seapoint
Enter gain and offset.
Concentration = (V * 30/gain) + offset
where

Gain is dependent on cable used (see cable drawing, pins 5 and 6)
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Note:

Offset and scale factor may be
adjusted to fit a linear regression
of fluorometer responses to
known chlorophyll a
concentrations.

WET Labs Flash Lamp Fluorometer (FLF) and Sea Tech
Enter scale factor and offset.

Concentration = (voltage * scale factor / 5) + offset

where

Scale factor is dependent on fluorometer range

Fluorometer Switch-Selectable Range Scale
(milligrams/m3 or microgramg/liter) Factor
Sea Tech 0-3 3

0 — 10 (default) 10

0-30 30

0-100 100

0-300 300
0-1000 1000

WET Labs 0-100 100

FLF 0 —300 (default) 300
0-1000 1000

Offset is calculated by measuring voltage output when the light sensor is
completely blocked from the strobe light with an opaque substance such
as heavy black rubber:  offset = - (scale factor * voltage) / 5

Turner 10-005

This sensor requires two channels - one for the fluorescence voltage and
the other for the range voltage. Make sure to select both when configuring
the instrument.

For the fluorescence voltage channel, enter scale factor and offset.
concentration = [fluorescence voltage * scale factor / (range * 5)] + offset
where

range is defined in the following table

Range Voltage Range
< 0.2 volts 1.0
>0.2volts and <0.55volts 3.16
>0.55volts and <0.85volts 10.0
> 0.85 volts 31.0

Turner 10-AU-005

Enter full scale voltage, zero point concentration, and full scale
concentration from the calibration sheet.

concentration = [(1.195 * voltage * (FSC — ZPC)) / FSV] + ZPC
where

voltage = measured output voltage from fluorometer

FSV = full scale voltage; typically 5.0 volts

FSC = full scale concentration

ZPC = zero point concentration

Turner SCUFA

Enter scale factor, offset, units, mx, my, and b from the calibration sheet.
chlorophyll = (scale factor * voltage) + offset

corrected chlorophyll = (mx * chlorophyll) + (my * NTU) + b

where

NTU = results from optional turbidity channel in SCUFA (see Turner
SCUFA in OBS equations below)

WET LabsAC3

This sensor requires two channels - one for fluorometer voltage (listed
under fluorometersin the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.

Enter kv, Vh2o, and A*X.

concentration (mg/m®) = kv * (Vout - Vh20) / A™x

where

Vout = measured output voltage

kv = absorption voltage scaling constant (inverse meters/volt)

Vh20 = measured voltage using pure water

A”x = chlorophyll specific absorption coefficient
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e  WET LabsWetStar and ECO-AFL

Enter Vblank and scale factor.
Concentration (ug/l) = (Vsample - V blank) * scale factor
where

Vsample = in situ voltage output

Vblank = clean water blank voltage output

Scale factor = multiplier (ug/l/Volt)

The calibration sheet lists Vblank and V copro (voltage output measured
with known concentration of coproporphyrin tetramethyl ester).
Determine an initial value for the scale factor by using the chlorophyl|
concentration corresponding to V copro:

scale factor = chlorophyll concentration / (V copro - V blank)

Perform calibrations using seawater with phytoplankton popul ations that
are similar to what is expected in situ.

Note: o OBS/Nephelometer Calibration Coefficients
In lgsn?rzl,tturmihtydsegsors are «  Backscatterance (Downing & Associates [D& A])
calibrated to a standar Entergainandoffset.

(formazin). However, particle size,

—_ * H
shape, refraction, etc. in seawater output = (volts * gain) + offset

varies. These variations affect the where o

results unless field calibrations gain = range/5; see calibration sheet for range

are performed on typical e Chdsea

water samples. Enter clear water value and scale factor.
turbidity [F.T.U.] = (10.0¥ —C) / scale factor
where

V = voltage from sensor
See calibration sheet for C (clear water value) and scale factor
e Dr.Haardt Turbidity

Enter AO, A1, BO, and B1. Select the gain range switch:

» Output Voltage Level if the instrument indicates gain by output
voltage level (< 2.5 voltsislow gain, > 2.5 voltsis high gain)
Low gain: vaue=A0+ (Al* V)

Highgain: value=B0+ (B1* V)

» Modulo Bit if the instrument has control lines custom-wired to bitsin
the SBE 9plus modulo word
Bit set: value=A0+ (A1* V)

Bit not set: value=B0+ (B1* V)

» Noneif the instrument does not change gain
value=A0+ (A1* V)

where

V = voltage from sensor

* IFREMER

This sensor requires two channels - one for the direct voltage and the

other for the measured voltage. Make sure to select both when configuring

the instrument.

For the direct voltage channel, enter vm0, vdO, dO, and k.

diffusion = [k * (vm—vmQ) / (vd —vd0)] — dO

where

k = scale factor vm = measured voltage
vmO0 = measured voltage offset vd = direct voltage

vdO = direct voltage offset do = diffusion offset

*  Seapoint Turbidity
Enter gain setting and scale factor.
output = (volts* 500 * scale factor)/gain
where
Scale factor is from calibration sheet
Gain is dependent on cable used (see cable drawing)
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*  Seatech L S6000
Enter gain setting, slope, and offset.
Output = [volts* (range/ 5) * dope] + offset
where
Slopeis from calibration sheet.
Range is based on sensor ordered (see calibration sheet) and cable-
dependent gain (see cable drawing to determineif low or high gain):

Rangefor High Gain | Rangefor Low Gain
2.25 7.5
7.5 25
75 250
225 750
33 100

*  Turner SCUFA
Enter scale factor and offset.
NTU = (scalefactor * voltage) + offset
corrected chlorophyll = (mx * chlorophyll) + (my * NTU) +b
where
mx, my, and b = coefficients entered for Turner SCUFA fluorometer
chlorophyll = results from fluorometer channel in SCUFA (see Turner
SCUFA in fluorometer equations above)

Oxidation Reduction Potential (ORP) Calibration
Coefficients

Enter M, B, and offset (mV).

Oxidation reduction potential = [(M * voltage) + B] + offset
Enter M and B from calibration sheet.

Oxygen Calibration Coefficients
Enter the coefficients, which vary depending on the type of oxygen sensor,

Notes:

1. Enter soc and boc values from
the most recent field calibration
for Beckman-type, YSl-type,
or Sea-Bird (SBE 43)

OXygen sensor.

2. See Application Notes 13-1 and
13-3 for complete description of
calculation of calibration
coefficients for Beckman- or
YSI-type sensors.

3. See Application Note 64 for
complete description of
calculation of calibration
coefficients for the SBE 43.

from the calibration sheet:

*  Beckman- or Y SI-type sensor (manufactured by Sea-Bird or other
manufacturer) - These sensors require two channels - one for oxygen
current (enter m, b, soc, boc, tcor, pcor, tau, and wt) and the other for
oxygen temperature (enter k and c). Make sure to select both when
configuring the instrument.

* |OW sensor - These sensors require two channels - one for oxygen current
(enter b0 and b1) and the other for oxygen temperature (enter a0, al, a2,
and a3). Make sure to select both when configuring the instrument.
Value=b0+[bl* (a0 +al* T +a2* T?+a3* T°) * C]
where
T is oxygen temperature voltage, C is oxygen current voltage

*  SeaBird sensor (SBE 43) - This sensor requires only one channel. Enter
soc, boc, offset, tcor, pcor, and tau.

OX =[Soc*{ (v+offset)+(tau* doc/dt)} +Boc* exp(-0.03t)] * exp(Tcor* t+Pcor* p)* OX SAT(t,s)
where

OX = dissolved oxygen concentration (ml/l)

t = water temperature (°C)

p = pressure (decibars)

s=sdlinity (PSU) - (ppt)

v = temperature-compensated oxygen current (Lamps)

doc/dt = slope of oxygen current (pamps/sec)
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Note:

See Application Notes 11 LICOR
(LI-COR sensor), 11 QSP-L
(Biospherical sensor with built-in
log amplifier), and 11-QSP-PD
(Biospherical sensor without
built-in log amplifier) for complete
description of calculation of
calibration coefficients.

Note:

SEASOFT-DOS < version 4.008
ignored temperature compensation of
a pH electrode. The relationship
between the two methods is:

pH = pH old + (7 — 2087/°K)

For older sensors, run pHfit version
2.0 (included with SEASOFT-DOS)
using Vout, pH, and temperature
values from the original calibration
sheet to compute the new values for
offset and slope to enter in the
configuration file.

PAR/Irradiance Calibration Coefficients

Enter M, B, calibration constant, multiplier, and offset.

PAR = [multiplier * (10° * 10V-B)/M) / calibration constant] + offset
where

M = 1.0 and B = 0.0 for integration with SBE 9plus [using light sensor
with built-in log amplifier (Biospherical model QSP-200L)];
or M and B are taken from log amplifier calibration sheet for integration
with SBE 16, 16plus, 19, 19plus, or 25
Calibration constant is dependent on sensor type:
» Biospherical PAR sensor
Calibration constant (for QSP-200L)
= 10°/ wet calibration factor from calibration sheet
Calibration constant (for QSP-200PD)
= 10° /calibration coefficient from calibration sheet
» LI-COR PAR sensor
Calibration constant is LI-COR in water calibration constant from
calibration shest.
Multiplier can be used to scale output, and is typically set to 1.0.

pH Calibration Coefficients

Enter the slope and offset from the calibration sheet:
pH =7 + (Vout — offset) / (°K * 1.98416e-4 * slope)
where

°K = temperature in degrees Kelvin

Pressure/FGP (voltage output) Calibration Coefficients
Enter scale factor and offset.

output [Kpa] = (volts* scale factor) + offset

where:

scale factor = 100 * pressure sensor range [bar] / voltage range [volts]
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Note:

See Application Note 7 for
complete description of
computation of M and B.

Transmissometer Calibration Coefficients
* SeaTech, Chelsea (Alphatracka), and WET Labs Cstar
Enter M, B, and path length (in meters)
Path length (distance between lenses) is based on sensor size
(for example, 25cm transmissometer = .25m path length, etc.).
light transmission (%) = M * volts + B
where
M = (Tw/WO0) (A0O-YO0)/ (A1-Y1)
=-M*Y1l
and
A0 = air calibration voltage (approximately 4.7 volts) from calibration
sheet
Al =current air voltage
Y0 = blocked path (dark) voltage (approximately 0.0 volts) from
calibration sheet
Y 1 = current blocked path (dark) voltage
WO = voltage output in pure water from calibration sheet
Tw = % transmission in pure water
Tw =% Transmission in Pure Water

Wavelength 10 cm Path Length | 25 cm Path Length
488 nm (blue) 99.8% 99.6%
532 nm (green) 99.5% 98.8%

660 nm (red) 96.0 - 96.4% 90.2-91.3%

Sea Tech Light Transmission Example

Tw =91.3, WO = 4.565, A0 = 4.743 volts, and YO = 0.002 volts
(from calibration sheet)

Al1=4.719 voltsand Y1 = 0.006 volts (from current calibration)
M =20.119

B =-0.1207

* WET LabsAC3
This sensor requires two channels - one for fluorometer voltage (listed
under fluorometersin the dialog box) and the other for transmissometer
voltage (listed under transmissometers). Make sure to select both when
configuring the instrument.
Enter Ch20, Vh2o, VDark, and X from calibration sheet.
Beam attenuation = {[log (Vh2o - VDark) - log (V - VDark)] /X} + Ch20
Beam transmission (%) = exp ( -beam attenuation * X) * 100

User Polynomial (for user-defined sensor) Calibration
Coefficients

Enter a0, al, a2, and a3.

Va =a0+(al* V) + (a2 * V2) + (a3 * V3

where:

V = voltage from sensor

a0, al, a2, and a3 = user-defined sensor polynomial coefficients

Zaps Calibration Coefficients
Enter M and B from calibration sheet.
z=(M * volts) + B [nmoles]
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Section 6: Acquisition,

Playback, and

Conversion of Raw Data Modules

M odule Name

Module Description

SEASAVE

Acquire real-time data, display raw archived data.
SEASAVE is a stand-alone module. See SEASAVE-
Win32 help files for details.

DATA
CONVERSION

Convert raw data (.hex or .dat file) to engineering
units, storing the converted datain .cnv file.

ROSETTE
SUMMARY

Summarize data from rosette (water sampler bottle)
rosfile, storing the resultsin .btl file.
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DATA CONVERSION

DATA CONVERSION:

1. Convertsraw datafrom an input .dat file (from an SBE 911plus) or
.hex file (from other CTDs) to engineering units, and

2. Storesthe converted datain a.cnv file and (optional) .rosfile.

The File Setup tab in the dialog box looks like this:

Location to store all information
input in File Setup and Data - -
Setup tabs. Open t0 select a | bkt His=i E3
different .psu file, Save or Fia  Opions  Help
Save As to save current
settings, or Restore to reset Fiz Sehup | Diata Setup | Heade: View |
all settings to match last |
; Fi
saved version. I B i o Select if more than 1 data file is to be
|I- \dlstahDishbet 151Dl sl posus processed, and data files have different
_— .con files. For example, if processing
Instrument configuration file Dipen.. | Save || Ervn A ,1 : H esioim | test.dat and testl.da_t, and this option is
location. Select to pick a ;elected, program will search for testl.con
different .con file, or Modify to | Inshument conligurstion lis (in the same directory as test.con) to
view and/or modify instrument S — process testl.dat.
configuration. (see below for |F '\t \Diebbie' 15f\est con
Configuration dialog box) Blart | Moy | #sich instiument conbipurslion b input Tl
Directory and file names for
raw data (.dat or .hex). Select Imput ceeciory
to pick a different file. To [H \data\Dubbieh 121
process multiple raw data files
from same directory: ~ Inged. fies, 1 selecled
1. Click Select.
beest d st | Selsct
2. In Select dialog box, hold | ——— J 4I
down Ctrl key while clicking Cutput duechory
on each desired file. ||_ \dal s\Dvabbe 151 camet |
= -
\ Directory and file names for converted output (.cnv) data.
« If more than 1 data file is to be processed, Output file field
I appenid
s I disappears and output file name is set to match input file
(gt dibe Ill:"l Brwr name. For example, if processing test.dat and testl.dat,
output files will be named test.cnv and testl.cnv.
Click Start Process to begin » SBE Data Processing adds Name append to (each) output
processing data. Status field Mol proceszng file name, before .cnv e?(tension. For example, if processing
shows Processing Complete test.dat'and testldat with a Name append of 06'20'00,
when done. output files will be test06-20-00.cnv and test106-20-00.cnv.
. |
Start Process , Edl Cawel |
/
/

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.
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The Configuration dialog box appears when you select M odify for the
instrument configuration file on the File Setup tab. The Configuration dialog
box is part of the CONFIGURE module (see Section 5: Configuring the
Instrument for full details for each instrument). The dialog box looks like this
for an SBE 9plus (other instruments are similar):

Configuration for the SBE 911/917 plus CTD

ASEIl file operied: None

= hantielz t £ =
TEfUEHY & SSERRTES |1_j> Channel/Sensor table below
Valtage wards to sUppress !_32 = reflects these choices.
Applicable only to

SBE 9plus. For full rate Caomputer interface

Select to include time of each scan
data, setto 1.

with data (if available in raw data file).

Scang to average

|
Shaded sensors cannot be removed
or changed to another type of sensor.

Selecting Surface PAR [ Surface PAF volage added 1 Scantime added
voltage adds 2 channels

- - All others are optional.
to table below. ™| NMER position data added p |
Channel _ ! - SenEr | Mew! |, New to create a new
1. Frequencyll | Temperature Gren | -con file for this CTD.
2 Frequency | Eonductivity Lk, Open to select a
3 Frequency 2 | Presstre, Digiquartz with TC Gaye | different .con file.
T—I;:_--—-———-E— S ound Velogitu 10w — |+ Saveor Save As to
R | 2OHNC. Ve, Saveds| save current .con file
_EVE'“ED_I Pressire. FGP settings.
E: Wolage 1 | Owpgen, SBE T
7. Maolkage 2 | Fluoromzter, Biosphiencal M atural hei
B Malkage 3 | &ltirmeter
.............. e
Click a (non-shaded) sensor and Click a sensor and click Modify to
click Select to pick a different change the calibration coefficients
sensor for that channel. A dialog for that sensor. See Section 5 for
box with a list of sensors appears. details on calibration coefficients.

Opens a .txt file (for viewing |
and printing only; cannot be |
modified) that shows all |

arameters in .con file.
P NN Repot. | Help | [Exit | Cancel

[

Return to File Setup tab.

« If Confirm Instrument Configuration Change was
selected in DATA CONVERSION's Options menu -
If you made changes and did not Save or Save As,
program asks if you want to save changes.

« If Confirm Instrument Configuration Change was not
selected in DATA CONVERSION's Options menu -
This button says Save & Exit. If you do not want to
save changes, use Cancel button to exit.

Note that the sensors and channelsin this dialog box must correspond to the
setup of your system. Y ou will select which data fields to convert and process
on the Data Setup tab of DATA CONVERSION's dialog box.
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Program skips first scans to skip

over scans.

« If Process scans to end of file
selected: process all
remaining scans (upcast
and downcast scans if Upcast
and downcast selected,;
downcast scans only if
downcast selected).

« If Process scans to end of file
not selected: process next
scans to process.

Select to replace existing
header in input file with header
in .hdr file. Program looks for a
file with a matching name (but
.hdr extension) in same
directory as input file.

N

Select which variables to
convert and output
(see dialog box below).

The Data Setup tab in the dialog box looks like this:

EE Data Conversion BEi=l

Fle (ptiens Help

File Setup  Data Setup | Header iew |

¥ Process scans toend of fils

Spang.ho skip over in
Seans o process I than

I.-’-‘«S Cll output = I

Oatput farmat

» Binary - smaller file, processed faster than ASCII
file by other SBE Data Processing modules.

* ASCII - larger file, can be viewed with a text editor.

TRANSLATE can translate converted data file from

binary to ASCII or vice versa.

Carwvert data from iLlpcast and downcast ll

Create converted data file only,
bottle file only (for subsequent
processing by ROSETTE
SUMMARY), or both.

Create file types

|Ereate both data and bottle file

=

Sourse of scan range data ISCEHS marked with b ttle confir bit

—\

LScan ramge offset {z]

Sr,:'ah ranoe duration [:3]_
I Merge separate header s

Select Dutput Variables... |

|

Define scans from
CTD data file to be
included in bottle file
for each bottle (see
discussion below).

Source of data for creating bottle file:

« In same directory as input data file, with
same file name - auto fire module .afm
file, bottle log .bl file, or bottle scan range
.bsr file, or

» Scans marked with bottle confirm bit in
input data file

See DATA CONVERSION: Creating Water

Bottle (.ros) Files below for details.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu -
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

If you made

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

N\

Start Process

\ Exit I

Caricel

The Select Output Variables dialog box (which appears when you click
Select Output Variables on the Data Setup tab) looks like this:

Selech Dyt Yanablos

tag i Pl [ |
| Prsemrs_Digauadz 4]
3 T enpesmiure [17 530, dag C]
i Corhiedsdb, [5m])
K]
]
E

list, click Insert.

* Add variable: click blank field in
Variable Name column, click desired
variable in list, click Add.

» Change variable: click existing variable
in Variable Name column, click desired
variable in list, click Change.

« Insert variable: click existing variable
below desired sequence # in Variable
Name column, click desired variable in

[ e
herge | BotomConiect Experd s
R | S o e
Dl I = Congur iy Efwird I
st “c Egnd |
Domid | n:.e;:.:::: :

Dispth

R EE

Corehu-iraly Dibaeras 3 -1

Dby, 2
Dby Diffacarsca. 3 - 1

[ienrerd Rae
Fregency Crannsl
Iebzschutips E o Cpnd

1o

Il Enn:-HI
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Note:

You can create a .bsr file in
a text editor if scan range
data is not available in any
of these forms.

DATA CONVERSION: Creating Water Bottle (.ros) Files

A .roswater bottle file contains:

» datafor each scan associated with a bottle firing, and

» datafor user-selected range of scans before and after each bottle firing

Scan range data for creation of a water bottle file can come from:

e Auto Fire module (.afm) file - if used PN 90208 Carousel Auto Fire
Module (AFM) with SBE 19 or 25 to interface with water sampler. For
these systems, the .afm file contains five scans of data recorded by the
AFM for each bottle firing.

»  Scans marked with bottle confirm bit in input data file - if used
SBE 911plusor SBE 9pluswith SBE 17plusto interface with water
sampler. For these systems, the bottle confirm bit in the input datafileis
set for all scans within a 1.5-second duration after a bottle firing
confirmation is received from the water sampler.

» Bottlelog (.bl) file - if used SEASAVE to interface with water sampler.
For these systems, SEASAVE creates the .bl file. Each time a bottle fire
confirmation is received, the bottle sequence number, position, date, time,
and beginning and ending scan humbers (1.5-second duration for each
bottle) are written to the .bl file.

* Bottle scan range (.bsr) file - if used Mark Scan featurein SEASAVE
during data acquisition to create a.mrk file; use MARK SCAN to convert
the .mrk file to a .bsr file before running DATA CONVERSION.

The format for the .bsr fileis
beginning scan # for bottle #1, ending scan # for bottle #1

beginning scan # for last bottle, ending scan # for last bottle

Example: test.bsr contains -

1000, 1020

2000, 2020

4000, 4020

The .rosfile created using test.bsr would contain scans 1000 - 1020 for
bottle #1, 2000 - 2020 for bottle #2, and 4000 - 4020 for bottle #3.

The amount of data written to the .rosfile is based on:

»  Scan range offset - determines the first scan output to the .rosfile for
each bottle, relative to the first scan with a confirmation bit set or written
to a.afm, .bsr, or .bl file.

»  Scanrange duration - determines the number of scans output to the .ros
file for each bottle.

Example: A bottle confirmation for an SBE 911plusisreceived at scan 10,000
(scan 10,000 and subsequent scans for 1.5 seconds have confirmation bit set).
In DATA CONVERSION, Scan range offset is set to -2 seconds, and Scan
range duration is set to 5 seconds. If the scan rate is 24 scans/second,

10,000 - 2 second offset (24 scans/second) = 9,952

9,952 + 5 second duration (24 scans/second) = 10,072

Therefore, scans 9,952 through 10,072 will be written to the .rosfile.
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DATA CONVERSION: Notes and General Information

DATA CONVERSION was written to accommodate most (if not all) sensors
that have been installed on Sea-Bird products. Consult the configuration page
at the beginning of your instrument manual for the sensors that were installed
in your system.

If you plan to post-process the data, select only the primary variables

to be converted. Use DERIVE to compute derived oceanographic
parameters such as salinity, density, sound velocity, oxygen, and dynamic
height anomaly.

If you will use DERIVE:

» To compute salinity, density, or other parameters that depend on
salinity - include pressure, temperature, and conductivity in the
output file

» To compute oxygen - include oxygen current and oxygen temperature
in the output file along with pressure, temperature, and conductivity

If you will use BIN AVERAGE:
»  With depth bins - include depth in the output file
»  With pressure bins - include pressure in the output file

Pressure temperature is computed using a backward-looking, 30-second
running average, to prevent bit transitions in pressure temperature from
causing small jumpsin computed pressure. Because the heavily insulated
pressure sensor has athermal time constant on the order of one hour,

the 30-second average does not significantly alter the computed

pressure temperature.

Oxygen values computed by SEASAVE and DATA CONVERSION wiill
be somewhat different from values computed by DERIVE, because the
oxygen algorithm uses the parameter doc/dt (derivative of oxygen current
with respect to time). SEASAVE and DATA CONVERSION compute
doc/dt looking backward in time, since they share common code and
SEASAVE cannot use future val ues of oxygen current while acquiring
datain rea time. DERIVE uses a centered window (equal number of
points before and after the scan) to obtain a better estimate of doc/dt. Use
SEASAVE and DATA CONVERSION to obtain a quick look at oxygen
values; use DERIVE to obtain the most accurate values.
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DATA CONVERSION has the following /x parameters when running from
the Run Options dialog box, from the command line, or with batch file

processing:
Ix PARAMETER | DESCRIPTION
/xdatcnv:skipN N = number of scansto skip.

Ixdatcnv:pump

For SBE 911plus, do not output scansif
pump status = off.

/xdatcnv:nomatch

Disable matching of header information to .con file -
program will continue to run even if thereisa
discrepancy in header information.

Note:

Each SBE Data Processing
module that modifies a .cnv file
adds information to the header
and updates nquan, nvalues,
name n, span n, interval, and
file_type, as applicable.

See Appendix |: Run Options, Command Line Operation, and Batch File Processing for details on

using parameters.

DATA CONVERSION adds the following to the data file header for a
.cnv converted datafile:

LABEL DESCRIPTION

Nquan Number of columns (fields) of converted data.
Note: DATA CONVERSION automatically adds
1 field to number selected by user (i.e., if user selects
3 variablesto convert, then nquan=4). Thisfield,
initially set to 0, isused by LOOP EDIT to mark
bad scans.

Nvalues Number of scans converted

Units Specified (indicates units are specified separately for
each variable; SEASOFT-DOS required all unitsto be
English or metric).

Namen Sensor (and units) associated with datain column n.

Spann Span (highest - lowest value) of datain column n.

Interval Scan rate (seconds).

Start_time Data start time.

Bad flag Provided for information only; value that LOOP EDIT
will use to mark bad scans and WILD EDIT will useto
mark bad data values.

Sensor n Sensor description, serial number, and calibration date.

Datcnv_date Date and time that module was run.

Datcnv_in Input .dat (or .hex) and .con files.

Datcnv_skipover Number of scansto skip over in processing.

File type Selected output file type - ascii or binary.

DATA CONVERSION adds the following to the data file header for a

.roswater bottlefile:

LABEL DESCRIPTION

Nquan Number of columns (fields) of converted data.
Note: DATA CONVERSION automatically adds
1 field to number selected by user (i.e., if user selects
3variablesto convert, then nquan=4). Thisfield,
initially set to 0, isused by LOOP EDIT to mark
bad scans.

Nvalues Number of scans converted.

Units Specified (indicates units are specified separately for
each variable; SEASOFT-DOS required all unitsto be
English or metric).

Namen Sensor (and units) associated with datain column n.

Interval Scan rate (seconds).

Start time Data start time.

Sensor n Sensor description, serial number, and calibration date.

Datcnv_date Date and time that module was run.

Datcnv_in Input .dat (or .hex) and .con files.

Datcnv_bottle Source of datafor creating bottle file, and scan range

scan_range source | offset and duration.
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ROSETTE SUMMARY

Note:
You can create a .sn filein a
text editor.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

ROSETTE SUMMARY reads a.rosfile created by DATA CONVERSION
and writes a bottle data summary to a.btl file. The .ros file must contain (as a
minimum) temperature, pressure, and conductivity (or salinity).
The output .btl fileincludes:
» Bottle position, optional bottle serial number, and date/time
»  User-selected derived variables - computed for each bottle from mean
values of input variables (temperature, pressure, conductivity, etc.)
»  User-selected averaged variables - computed for each bottle from
input variables
The maximum number of scans processed per bottle is 1440.

In addition to the .rosinput file:

* If a.bl file (same name as input datafile, with .bl extension) isfound in
the input file directory, ROSETTE SUMMARY uses bottle position data
from the .bl file. The bottle position data defines the bottle firing sequence
- the first column is the firing sequence number and the second columnis
the bottle position.

* Ifa.snfile(same name asinput datafile, with .sn extension) is found in
the input file directory, bottle serial numbers are inserted between the
bottle position and date/time columnsin the .btl file output. The format
for the .snfileis:

Bottle position, serial number  (with a comma separating the two fields)

The Data Setup tab in the dialog box looks like this:

B Hoselie 5 umnomy
Ei= Qpliors Help

FimSelup Dol Sehsn | Huade View |

¥ Dldper minmas vabust fon wvmsged verisbles

Select input variables to be averaged. Mean and

Gedmct & varsged Vaisbles | standard deviation will be calculated and output for

each bottle.

« If Output min/max values for averaged variables
is selected, minimum and maximum values will

also be output for each bottle.

\Seh-cl Dimrrsmd ! moagbiss |

Select variables to derive from input data. Derived variables
are computed from mean values of input variables
(temperature, conductivity, pressure, etc.) for each bottle.

* Oxygen can be derived if oxygen current and oxygen
temperature are in the .ros file. ROSETTE SUMMARY
calculates doc/dt, using a least squares fit to all the oxygen
current data for each bottle. Oxygen is calculated using the
mean values for temperature, pressure, and salinity,
doc/dt, and the scan-by-scan values of oxygen current and
oxygen temperature.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

/ ]

EllrlF'rm:l:ﬁl Ext ’ | cowe |

ROSETTE SUMMARY adds the following to the data file header:

LABEL DESCRIPTION
Rossum_date Date and time that module was run.
Rossum in Input .ros and .con files.
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Section 7: File Editing Modules

M odule Name

Module Description

ASCII IN

Add header information to a .asc file containing rows
and columns of ASCII data.

MARK SCAN

Create .bsr bottle scan range file from .mrk datafile.

SECTION

Extract rows of datafrom .cnv file.

SPLIT

Split datain .cnv fileinto upcast and downcast files.

STRIP

Extract columns of data from .cnv file.

TRANSLATE

Convert dataformat in .cnv file from ASCII to binary,
or vice versa
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ASCII IN

Note:

The File Setup tab is similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

ASCII IN adds a header to a .asc file that contains rows of ASCI| data. The
data can be separated by spaces, commas, or tabs (or any combination of
spaces, commas, and tabs). The output file, which contains both the header and
the data, isa.cnv file. ASCII IN can be used to add a header to data that was
generated by a non-SEASOFT program.

The Data Setup tab in the dialog box looks like this:

Pl Sehp Dt Sebag |

s B — pressure, or depth, and indicate
@ the interval value (time, pressure,
Sran inberysl ke ||:| ] or depth between scans). This
information is put in header.
ot Lok Marsez |

Select whether interval between
scans is based on time,

Select variable name associated
with each column of data, to be
put in header. Selection list
includes all variables that can be
output by DATA CONVERSION
and DERIVE, as well as user-
defined variable names.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Sl Profess I

ASCII IN creates a data file header containing the following information:

LABEL DESCRIPTION
Nquan Number of columns (fields) of data.
NOTE: ASCII IN automatically adds 1 field to the number
of fieldsin theinput .asc file (i.e., if the .asc file contains
3 columns of data, then nquan=4). Thisfield, initially set to O,
isused by LOOP EDIT to mark bad scans.

Nvalues Number of scans converted.

Units Specified (indicates units are specified separately for each
variable; SEASOFT-DOS required all unitsto be English
or metric).

Namen Sensor (and units) associated with datain column n.

Spann Span (highest - lowest value) of datain column n.

Interval Scan rate (seconds).

Start time | Start time for when ASCII IN was run.

Bad flag | Provided for information only; value that LOOP EDIT will
use to mark bad scans and WILD EDIT will use to mark bad
data values.

Asctiiin_in | Input .ascfile.

Filetype | Selected output file type - ascii data.
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MARK SCAN

Note:

Alternatively, an ASCII text editor can
be used to create the .bsr file. The
format for the output .bsr file is:
Beginning scan for bottle 1, ending scan for
bottle 1

Beginning scan for bottle 2, ending scan for
bottle 2

Beginning scan for last bottle, ending scan
for last bottle

Note that a comma must separate the
beginning and ending scan numbers.

Note:

The File Setup tab is similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

MARK SCAN creates a bottle scan range (.bsr) file from a.mrk datafile
created in SEASAVE. The datain the .bsr file can then be used by DATA
CONVERSION to create a .rosfile. The .ros file can then be used by
ROSETTE SUMMARY to create a bottle data summary .htl file.

Theinput .mrk file contains one scan with the mark number, system time, and
scan number for each time Mark Scan was clicked whilein SEASAVE’'s Mark
Scan Control dialog box (accessed by selecting Mark Scan Control in
SEASAVE's View menu). MARK SCAN's output .bsr file points to a user-
defined range of adjacent scans for each marked scan. Note that the output .bsr
file only contains the pointers to the scans, and does not contain the data.

The Data Setup tab in the dialog box looks like this:

EE Mark Scan

File Options  Help

P [=] 3

File Setyp DlataSetup I
|

|E > Define the range of scans around each scan in
|1EI

Oifset [soang]

the .mrk file to include in the .bsr file.

« offset - number of scans before or after scan
in .bsr file for starter pointer

« duration - number of scans to include in .bsr
file for each scan in .mrk file

Example: Offset is -5 scans and duration is

10 scans. If .mrk file contains scans 16 and

128, .bsr file will look like this:

11,21 (16-5=11; 11+10=21)

123, 133 (128-5=123; 123+10=133)

Dlurahiah [soans]

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Exit Cancel I

N\ |
Start Process I

MARK SCAN'’s output .bsr file does not have a header.
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SECTION

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

SECTION extracts rows of datafrom the input .cnv file, based on a pressure
range or scan number range, and writes the rows to an output .cnv file.

The Data Setup tab in the dialog box looks like this:

He Dobom - Heip

Fie Setup Data Sehp | Header View | SECTION based on a pressure range

£t actae] a1 Worascanrange.

Select Upcast or Downcast if
section is based on pressure.

|~ Prsing sechon cas |r.m“.,_.=._| ...|

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

P i b |
4 > SECTION writes to the output file

M sy vaha |.-J all rows of data that fall within this
range of pressure or scan number.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

]

N\
Start Process | @ | coen |

SECTION adds the following to the data file header:

LABEL DESCRIPTION

Section_date Date and time that module was run.

Section_in Input .cnv file.

Section_type Evaluate data based on pressure or scan range.
Section_range Range of (pressure or scan count) data to keep.

55



Section 7: File Editing Modules

SPLIT

Note:

BIN AVERAGE provides the option of
processing upcast, downcast, or
both, possibly removing the need to
run SPLIT.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

SPLIT separates the data from an input .cnv file into upcast (pressure
decreasing) and downcast (pressure increasing) files. SPLIT writes the data
to an output .cnv file(s). The upcast output file name is the input file name
prefixed by u. The downcast output file name is the input file name prefixed
by d.

The Data Setup tab in the dialog box looks like this:

=] 3

& Split
Fie Options  Help

File Setup  Data Setup l Header viéwl Output an upcast file (prefix u) and

T downcast (prefix d) file, or just a
downcast (prefix d) file.

|Ipcast and downcast

Output files

W Exelude scans marked bad

If selected, scans marked with badflag (in
LOOP EDIT) will not be used to identify
maximum pressure. Maximum pressure
defines when downcast ends and upcast
begins.

Note: Pressure values marked with
badflag in WILD EDIT are never used to
determine maximum pressure.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows

Begin processing data. Status field

Processing complete when done.

N\ |
e | o |

Start Process

SPLIT adds the following to the data file header:

LABEL DESCRIPTION
Split_date Date and time that module was run.
Split_in Input .cnv file.

Split_excl_bad_scans | If Yes, pressure from scans marked with badflag (in
LOOP EDIT) were not used to determine
maximum pressure (for determining when

downcast ends and upcast begins).
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STRIP
STRIP outputs selected columns of datafrom the input .cnv file. STRIP writes
the data to an output .cnv file.
Note: The Data Setup tab in the dialog box looks like this:

The Fil Setup tab and T -

Header View tab are similar Fis (pbons Hep

for all modules; see Section 2:
SBE Data Processing FinSep Dot Sk | Hmace Vi |

Installation and Use. |'§Ee:.||' T ;]\

Select which variables (columns
of data) to output.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \ |
on File Setup tab shows X
Processing complete when done. Slar Proteas I E:d | canes |

STRIP adds the following to the data file header:

LABEL DESCRIPTION

Strip_date | Date and time that module was run.

Strip_in Input .cnv file.
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TRANSLATE

TRANSLATE changes the converted data file format from binary to ASCII or
vice versa, and writes the data to an output .cnv file.

Note: The Data Setup tab in the dialog box looks like this:

The File Setup tab and BE Translate ol =]

Header View tab are similar il Diicis: . el

for all modules; see Section 2: Sestaniiasal

SBE Data Processing Fie Setup Data Setup | Header View |

Installation and Use. |

|na[y Frab Switch from:

» Binary to ASCII,

* ASCII to binary, or

» Binary to ASCII or ASCII to binary,
as applicable

Tranglatian I

Translaté to opposite

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field / |

on File Setup tab shows = ’—‘—I =
Processing complete when done. Start Process A Cancel |

TRANSLATE changes the following in the data file header:

LABEL DESCRIPTION

File type File type - changesto ascii or binary, as applicable.

58



Section 8: Data Manipulation Modules

Section 8: Data Manipulation Modules

All data manipulati

onis performed on converted data from a.cnv file.

M odule Name

Module Description

ALIGNCTD

Align datarelative to pressure (typically used for
conductivity, temperature, and oxygen).

BIN
AVERAGE

Average data, basing bins on pressure, depth, scan
number, or time range.

BUOYANCY

Compute Brunt Vaisala buoyancy and stability
frequency.

CELL
THERMAL
MASS

Perform conductivity thermal mass correction.

DERIVE

Calculate salinity, density, sound velocity, oxygen,
potential temperature, dynamic height, etc.

FILTER

L ow-pass filter columns of data.

LOOPEDIT

Mark a scan with badflag if scan fails pressure reversal or
minimum velocity tests.

WILD EDIT

Mark a data value with badflag to eliminate wild points.

WINDOW
FILTER

Filter data with triangle, cosine, boxcar, gaussian, or
median window.
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ALIGN CTD

Note:

ALIGN CTD cannot be run on files
that have been averaged into
pressure or depth bins in BIN
AVERAGE. If alignment is necessary,
run ALIGN CTD before running

BIN AVERAGE.

Pressure

Aligned relative \
to pressure

Downcast

Upcast and Downcast mismatch with
Respect to Pressure

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

ALIGN CTD aligns parameter datain time, relative to pressure. This ensures
that calculations of salinity, dissolved oxygen concentration, and other
parameters are made using measurements from the same parcel of water.
Typically, ALIGN CTD isused to align temperature, conductivity, and oxygen
measurements relative to pressure.

There are three principal causes of misalignment of CTD measurements:

physical misalignment of the sensors in depth

inherent time delay (time constants) of the sensor responses

water transit time delay in the pumped plumbing line - thetime it takes
the parcel of water to go through the plumbing to each sensor (or, for free-
flushing sensors, the corresponding flushing delay, which depends on
profiling speed)

When measurements are properly aligned, salinity spiking (and density) errors
are minimized, and oxygen data corresponds to the proper pressure (e.g.,
temperature vs. oxygen plots agree between down and up profiles).

The Data Setup tab in the dialog box looks like this:

BE dlign CT0 AEE

Fla gt - Help
Fie Senp  DofnSetup | Header e |

Enbsr Addvanos Y shes. i ———Define alignment times for all data.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

\

Start Process | Ba |

The Enter Advance Values dialog box looks like this:

e Mvancaaboes ____________________H

Define alignment times. The

Ad Ad Wisasbles M s [l fgkance |rec] E_QHH diagram shows the sign
+ Advance - Advance i
Terpersiue | T3-30, deg L] | convention for Advance. If
<4 (delay) —p = 0 seconds is entered, alignment
Conauctiviy 15 . ; .
. Cieit B ™ — relatlye to pressure (and time)
Time Copgen - Becknan/ = remains unchanged for that

Copgen T emperdune, Beckraarns'rS (deg C) | variable. See discussion below to
e, Bt mand5| ] determine appropriate alignment

times for conductivity,

ok temperature, and oxygen.
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Pressure

ALIGN CTD: Conductivity and Temperature

Temperature and conductivity are often misaligned with respect to pressure.

Shifting temperature and conductivity relative to pressure can compensate.

As shown in the figures, indications of misalignment include:

*  Depth mismatch between downcast and upcast data

»  Spikesin the calculated salinity (which is dependent on temperature,
conductivity, and pressure) - caused by misalignment of temperature and
conductivity with each other

The best diagnostic of proper alignment is the elimination of salinity spikes
that coincide with very sharp temperature steps. To determine the best
alignment, plot 10 meters of temperature and salinity data at a depth that
contains a very sharp temperature step. For the downcast, when temperature
and salinity increase with increasing pressure:

* A negative salinity spike at the conductivity step means that conductivity
leads temperature (conductivity sensor sees step before temperature sensor
does). Advance conductivity relative to temperature a negative number
of seconds.

» Conversdly, if the salinity spike is positive, advance conductivity relative
to temperature a positive number of seconds.

E Negative :
o ospike L.

|
|
|
=
|

 Salinity

||||||||||

Positive t No :
i spike spike
E e L
[ ) e @ .
SE : 5 4
[0 o = oy = .
3 : Salinity 3 :Salinity
af . a :

Downcast, Conductivity leads Temperature

Downcast, Conductivity lags Temperature Downcast, C and T Aligned

The best alignment of conductivity with respect to temperature is obtained
when the salinity spikes are minimized. Some experimentation with different
advancesis required to find the best alignment.

When using free flushing conductivity sensors, keep the profiling speed
greater than 0.7 meters/second, because of thermal contamination of the
conductivity measurement at lower speeds.

Typical Temperature Alignment

*  SBE 19 and 19plus - Because the SBE 19 and 19plus use a temperature
sensor with arelatively slow time constant, atypical correctionisto
advance temperature relative to pressure + 0.5 seconds.

*  SBE 9plus and SBE 25 - Because the time response of the SBE 3
temperature sensor is fast (0.06 seconds), it is not necessary to advance
temperature relative to pressure for the SBE 9plus and 25 (which use the
SBE 3).
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Note:

All SBE 11 series deck units can
advance primary conductivity, which
may eliminate the need to use ALIGN
CTD. The SBE 11plus does not
advance secondary conductivity.

The SBE 11plus V2 can advance
secondary conductivity and all
voltage channels; the advance time is
user-programmable.

Advance C relative to T +0.073 seconds

(use SBE 11 series deck unit and/or ALIGN CTD)
P E——

7/ | C/i

/

fa— ClagsTby —» Time

0.073 seconds

Typical Conductivity Alignment

*  SBE 9plus- For an SBE 9plus with TC-ducted temperature and
conductivity sensors and a 3000 rpm pump, the typical lag of conductivity
relative to temperature is 0.073 seconds. Following is an example of
determining the value to enter in ALIGN CTD:

Example: The SBE 11plusis factory-set to advance the primary
conductivity +1.75 scans (at 24 Hz, thisis 1.75/24 = 0.073 seconds).
Advance conductivity relative to temperaturein ALIGN CTD:
0.073- 1.75/24 = 0.0 seconds  (enter O seconds for conductivity).

* SBE 19 and 19plus - For agiven sensor configuration, the conductivity
measurement may lead or lag that of temperature. Thisis especially true
of unpumped SBE 19 data, where the flushing rate of the conductivity cell
depends on drop speed. If the SBE 19 islowered very slowly (<
20cm/second, typically from afixed platform or ice), conductivity lags
temperature. If the SBE 19 is lowered fast, conductivity leads
temperature. Typical advances of conductivity relative to temperature
range from O seconds at alowering rate of 0.75 meters/second to -0.6
seconds for 2 meters/second (if temperature was advanced +0.5 seconds,
these correspond to conductivity advances of +0.5 seconds and -0.1
seconds respectively).

*  SBE 25 - For an SBE 25 with a standard 2000 rpm pump, atypical
advance of conductivity relative to temperature is +0.1 seconds.

Notethat if temperatureisadvanced relative to pressure and you do not
want to change therelative timing of temperature and conductivity, you
must add the same advance to conductivity.

Example (typical of SBE 19 data):

Advance temperature relative to pressure +0.5 seconds to compensate for slow
response time of sensor.

If the CTD islowered at 0.75 m/s, advance conductivity relative to
temperature 0 seconds. Calculate advance of conductivity relative to pressure
toenter in ALIGN CTD: +0.5 + 0 = +0.5 seconds

If the CTD islowered at 2 m/s, advance conductivity relative to temperature
-0.6 seconds. Calculate advance of conductivity relative to pressureto enter in
ALIGN CTD: +0.5 + (-0.6) = -0.1 seconds

ALIGN CTD: Oxygen

Oxygen datais also systematically delayed with respect to pressure. The two
primary causes are the long time constant of the oxygen sensor (ranging from
2 seconds at 25 °C to approximately 5 seconds at 0 °C) and an additional delay
from the transit time of water in the pumped plumbing line. Aswith
temperature and conductivity, you can compensate for this delay by shifting
oxygen data relative to pressure. Typical advances are;
*  SBE 9plus: +2 to +5 seconds (pumped), +1 to +5 seconds (unpumped)
 SBE19and 19plus:

+3 to +7 seconds (pumped), +1 to +5 seconds (unpumped)
*  SBE 25: +3to +7 seconds (pumped), +1 to +5 seconds (unpumped)

ALIGN CTD adds the following to the datafile header:

LABEL DESCRIPTION

Alignctd_date Date and time that module was run.

Alignctd_in Input .cnv file.

Alignctd_adv Variables aligned and their respective alignment times.
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BIN AVERAGE

Note:

ALIGN CTD, which aligns parameter
data in time, relative to pressure,
cannot be run on files that have been
averaged into pressure or depth bins
in BIN AVERAGE. If alignment is
necessary, run ALIGN CTD before
running BIN AVERAGE.

Note:

The File Setup tab and Header View
tab are similar for all modules; see
Section 2: SBE Data Processing
Installation and Use.

Eie Dptions - Help

BIN AVERAGE averages data, using
pressure range,

depth range,

scan number range, or

time range

averaging intervals based on:

The Data Setup tab in the dialog box looks like this:

&% Bin Average

File Getup DataSetup | HeaderVien |

Bin type IF‘res&ure

If selected, a column containing number of
scans in each bin will be added to output data.

If selected, data from scans marked with
badflag in LOOP EDIT will not be used in
calculating average. Note that values marked
with badflag by WILD EDIT are never
included in calculating average.

Eiml B2

Average by:

» pressure (with or without interpolation)

» depth (with interpolation)

» scan number

» time (seconds or hours)

If pressure (or depth) is not included in input
file, it will not appear on list of bin types.

Bin size is range of data for each bin (i.e.,
pressure range, scan number range, etc.).

Iticlade riumber of soars per bin

ﬁs Exchude spans maked bad

Skip firs

beginning processing.

t n scans of data before

Soahs o skip over ig pd

Cast to process iLIpu:ast and dowincast |

If selected, include surface bin (applicable only if

averaging by pressure or depth). Input:

* minimum and maximum values - minimum and
maximum (pressure or depth, as applicable) to
be used in calculating surface bin

» value - target value (pressure or depth) to be
associated with averages

Note that surface bin minimum, maximum,

and value do not affect minimum, maximum,

and center of first or subsequent bins.

% Include surface bin
Burface bin minimum valus ig

Siiface bin magimum valie Ig
IEI

Qurfau:a biry walue

IProcess downcast, upcast, or both.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

says Save & Exit. If you do not wan

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu -
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button

If you made

t to save changes, use Cancel button to exit.

Start Process |

Esit / I Cancel

Note:

If Exclude scans marked bad is
selected in the dialog box, data from
scans marked with badflag in LOOP
EDIT are not used in calculating
average. Values marked with badflag
by WILD EDIT are never included in
calculating the average. If the
number of points included in the
average is O (all data and/or scans in
the bin are marked with badflag), the
average value is set to badflag.

BIN AVERAGE: Formulas

The center value of the first (not surface) binis set equal to the bin size.

Example (pressure bin, surface bin not included):
Bin sizeis 10 db. Thefirst bin is defined as follows:

surface = 0 db

Minimum first bin = BinMin =

First bin

bin size - (bin size/2) =5 db

Center (target) first bin =

Bin size=10 db

bin size=10 db

Maximum first bin = BinMax =
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Example (pressure bin, surface bin included):
Bin sizeis 10 db. Surface bin isincluded, and surface bin parameters are O db
minimum, 3 db maximum, and 0 db value. The bins are defined as follows:

minimum surface bin =0 db

target surface bin = 0 db
¢ Surface bin
Bin size=3 db maximum surface bin = 3 db

Minimum first bin = BinMin =
bin size - (bin size/2) =5 db

First bin Center (target) first bin =
Bin size=10 db bin size=10 db

Maximum first bin = BinMax =
bin size + (bin size/2) = 15 db

The algorithms used for each type of averaging follow.

Pressure Bins (no interpolation)

For each bin:

BinMin = center value - (binsize/ 2)
BinMax = center value + (bin size/ 2)

Add together valid data for scans with BinMin < pressure < BinMax.
Divide the sum by the number of valid data points to obtain the average.
Write the average to the output file.

Repeat Steps 1 through 3 for each variable.

For the next bin, compute the center value and repeat Steps 1 through 4.

ghrwdhpE

Pressure Bins (with interpolation)
For each bin:

BinMin = center value - (binsize/ 2)
BinMax = center value + (bin size/ 2)

1. Add together valid data for scans with BinMin < pressure < BinMax.
2. Divide the sum is by the number of valid data points to obtain the average.
3. Interpolate asfollows:
P, =average pressure of previous bin
X, =average value of variable in previous bin
P, =average pressure of current bin
X =average value of variablein current bin
P, = center value for pressure in current bin
X; =interpolated value of variable (value at center pressure P,)
=((xc'xp)* (Pi'Pp)/(Pc'Pp))"'xp
4. Writetheinterpolated value to the output file.
5. Repeat Steps 1 through 4 for each variable.
6. Compute the center value and Repeat Steps 1 through 5 for the next bin.

Values for the first bin are interpolated after the averages for the second bin
are calculated; values from the next (second) bin instead of the previous bin
are used in the equations.

Depth Bins

Depth bin processing is similar to processing for pressure bins with
interpolation, but bin size and center values are based on depth.
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Scan Number Bins

Scan number bin processing is similar to processing for pressure bins without
interpolation. If exclude scans marked bad is selected, BIN AVERAGE
averages bin size good scans (not marked with badflag in LOOP EDIT).

Example: Bin size is 100. First bin should include scans 50 - 149. However,
scans 93, 94, and 126 are marked with badflag in LOOP EDIT, and the user
selected exclude scans marked bad. To include 100 valid scans in the average,
BIN AVERAGE includes scans 50 - 152 in the first bin.

TimeBins

Time bin processing is similar to processing for pressure bins without
interpolation. BIN AVERAGE determines the number of scansto include
based on the input bin size and the data sampling interval:

Number of scans = bin size [seconds] / interval

or
Number of scans = (bin size [hours] x 3600 seconds/hour) / interval

BIN AVERAGE adds the following to the data file header:

LABEL DESCRIPTION

Binavg date Date and time that module was run.

Binavg in Input .cnv file.

Binavg_bintype Bin type (pressure, depth, scans time in seconds, or
timein hours).

Binavg binsize Bin size.

Binavg_excl_bad_ If yes, values from scans marked with badflag in

scans LOOP EDIT are not included in average.

Binavg skipover Number of scans skipped over.

Binavg_surface bin | Surface binincluded? Minimum and maximum
values for surface bin.
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BUOYANCY

Note:

The input .cnv file for BUOYANCY
must have been processed with BIN
AVERAGE on pressure bins (with or
without interpolation) and must
contain pressure, temperature, and
either salinity or conductivity.

(E) using the Fofonoff adiabatic

The Data Setup tab in the dialog

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

Select buoyancy
variables to be
computed and added
to.cnvfile-1,2,3,
or 4 variables can be
computed.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

EZ Buoyancy Hi=l

BUOYANCY calculates buoyancy (Brunt-Vaisald) frequency (N) and stability

leveling method (Bray N. A. and N. P.

Fofonoff (1981) Available potential energy for MODE eddies. Journal of
Physical Oceanography, 11, 30-46.).

box looks like this:

File: Dptions - Help

File Setup Data Setup | Header View

Bugyiancy Yariahle

Select variable used in buoyancy computation:

o Latitude - BUOYANCY uses algorithm in UNESCO
Technical Papers in Marine Science 44 to estimate
local gravity from user-input latitude

» Gravity

| ahttide

—

Girenity [rn/'s 2]

\Window size [db] i-||:| \
[~ Stahility. E [rad"2m]
I~ Siahility. £ [10°8 1ad*2/m]

Buoyancy frequency [N 2 1ad”24:°2]

Buotancy frequency [N, cuclesdhaur]

Calculate buoyancy variables for pressure values
centered in window. BUOYANCY converts window
size from decibars to scans based on pressure
interval between scans in input file. If window size is
less than three scans, BUOYANCY sets it to three
scans. If window size is an even number of scans,
BUOYANCY adds one scan to window size. (see
example below)

Note:

As used here, a scan is one row of output data from
BIN AVERAGE, which is an average of many scans
of original data.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

N\ |

Start Process

Save k Exl I Cancel |

Example: For an interval of 10 db between scans, buoyancy window sizes of
5, 10, or 20 db result in awindow size of three scans. Window sizes of 30 or
40 db result in awindow size of five scans.

10 db 20 db

30db 40 db 50 db

<

5 db window = 3 scan minimum

<

10 db window = 3 scan minimum

420 db window = 3 scans (10, 20, 30d

< 30 db window = 4 scans (10, 20, 30, 40 db) + 1 scan tcﬁﬁake odd number >

>

< 40 db window = 5 scans (10, 20, 30, 40, 50 db)
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BUOYANCY: Formulas
The relationship between frequency N and stability E is:

N2=gE [rad¥s]
where g = gravity [m/ &7

The algorithm used to compute N? for the pressure val ue centered in the
buoyancy window is:

1. Compute averages:
p_bar = average pressure in the buoyancy window [decibars]
t_bar = average temperature in the buoyancy window [deg C]
s bar = average salinity in the buoyancy window [PSU]
rho_bar = density (s_bar, t_bar, p_bar) [Kg/ m’]

2. Computethe vertical gradient:
theta = potential temperature (s, t, p, p_bar)
v =1/ density(s, theta, p_bar)
wheres, t, and p are the averaged values for salinity, temperature, and
pressure calculated in BIN AVERAGE

Use aleast squares fit to compute the linear gradient dv/dp in the
buoyancy window.

3. Compute N? N, E, and 10 °E:

N 2= -1.0e” rho_bar *g? ‘g_: [rad%/s?]

3600
N=">n VN2 [cycles’hour]

E= [rad?/m]

2

[10®rad?/m]

BUOYANCY adds the following to the data file header:

LABEL DESCRIPTION
Buoyancy date Date and time that module was run.
Buoyancy in Input .cnv file.

Buoyancy vars | Gravity value (input value or val ue based on input
latitude) and buoyancy window size (adjusted to provide
a minimum of three scans and an odd number of scans).
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CELL THERMAL MASS

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

CELL THERMAL MASS uses arecursive filter to remove conductivity cell
thermal mass effects from the measured conductivity. In areas with steep
temperature gradients, the thermal mass correction is on the order of

0.005 PSU. In other areas the correction is negligible. Typical values for

alphaand l/beta are:
Instrument alpha 1l/beta
SBE 9plus with TC duct and 3000 rpm pump 0.03 7.0
SBE 25 with TC duct and 2000 rpm pump 0.04 8.0

The Data Setup tab in the dialog box looks like this:

B Cefl Thisimal Mas§
Fie  Qpbon: - el

Pl Setp  Datm Sk | Himacen Vieww |

Cootrescd [y cOrabrinly et

Use primary or secondary
temperature sensor data for
filtering the conductivity data.

Teraeishae daf b Us

Thesws Sromsle ampbiude |siphs] "(—

values.

Filter primary and/or
secondary conductivity

Thermal aromsly bre corstant |1 als) i:-

\F -E_-I:i'm:l e e

Temupershas Jefr b U

Therwes secreslp srapbiuds | alpks) f.('-
Theral sromaly e corctant |1 fels] i"—

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows

Begin processing data. Status field

Processing complete when done.

\Sltﬂﬁmu| Tl Cancel |

CELL THERMAL MASS: Formulas
The agorithm used is:

dt = temperature - previous temperature
ctm=-1.0 * b* previousctm + a* (dc/dt) * dt
corrected conductivity = ¢ + ctm

where:

a=2* alpha/ (sampleinterval * beta + 2)
b=1-(2* a/alpha)

dc/dt =0.1* (1 + 0.006 * [temperature - 20])

To determine the values for apha and beta, see:
Lueck, R.G., 1990: Thermal Inertia of Conductivity Cells: Theory., American
Meteorological Society Oct 1990, 741-755.

CELL THERMAL MASS adds the following to the data file header:

LABEL DESCRIPTION

Celltm date Date and time that module was run.

Celltm in Input .cnv file.

Celltm_alpha Value used for alpha.

Celltm tau Value used for 1/beta.

Celltm_temp_sensor | Temperature sensor for primary conductivity filter,
_use for_cond temperature sensor for secondary conductivity filter.
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DERIVE

DERIVE uses pressure, temperature, and conductivity from the input .cnv file

Note:

The File Setup tab for DERIVE
requires selection of both an input
data file and an instrument
configuration (.con) file before it will
process data. However, an

SBE 37-SM, 37-IM, 39, and 48
stores calibration coefficients
internally, and does not have a .con
file. For these and any other
instruments with internal calibration
coefficients, select any .con file (or
create and select an empty file with a
.con extension); the contents of the
file will not affect the results.

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

to compute the following oceanographic parameters:

density (density, sigma-theta, sigma-t, sigma-1, sigma-2, sigma-4)
depth (salt water, fresh water)

dynamic meters

geopotential anomaly

potential temperature (reference pressure = 0.0 decibars)

potential temperature anomaly

salinity

sound velocity (Chen-Millero, Del Grosso, Wilson)

average sound velocity

specific volume anomaly

thermosteric anomaly

descent rate and acceleration (if input file has not been averaged into
pressure or depth bins)

oxygen (if input file contains pressure, temperature, and either
conductivity or salinity, and has not been averaged into pressure or
depth bins)

The Data Setup tab in the dialog box looks like this:

B Qpioes  Help

Fis Gelup  [iaba Gelap |Hm i ||

[ 5kt Dortvad Ve |

Select variables to
be calculated.

Return to SBE Data Processing window.

If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.
If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

on File Setup tab shows
Processing complete when done.

Begin processing data. Status field

\

Silart Prostesa I

\
Bd | Cown
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The Select Derived Variables dialog box looks like this:

B Marinb hlarsa furi] s [F

A1 Aneleation -

Doarviiby [devedtp K ™)

1) Aneiags Soured Valooap

Chaapaths [zt et ]

Charviey

2 el P55 11]

3 oo Welecky [Chan-Fillan, ']

deraty, Kpin™]
mgraa-ihets, Fagim

I."'"-u.""'\l—'.:

eyl K]

» Add variable: click blank field in
Variable Name column, click desired
sensor in sensor list, click Add.

» Change variable: click existing sensor
in Variable Name column, click desired
sensor in sensor list, click Change.

« Insert variable: click existing sensor
below desired sequence # in Variable
Name column, click desired sensor in
sensor list, click Insert.

If DERIVE requires additional information

to compute a variable, a dialog box

appears after variable is selected, with
fields for required user-input parameters.

EREE

ey, Egdve 3
sy K3

=gnad, Egtn™3

51 Clapth

3 Dprmn by

Clrearar: W edss [10.1%]

Gl erisl Sowrashe fLY]

i) Dbpuipian Baluisln

il Polantial T erpeisties

41 Froiantid T erpecstuss Snomasks

by (P51
v

=| 1 oand ekooly El

0k | Coed |

| Click Data to view/modify user-input parameters for selected variable (if applicable).
Some variables share a user-input parameter, so changing the parameter for one

variable automatically changes it for the other:

» Descent rate and acceleration use the same time window size
« All oxygen sensors use the same time window size

DERIVE: Formulas

General Information:

Temperature used for derived variablesis IPTS-68.

Following the recommendation of JPOTS, Teg is assumed to be

1.00024 * Tgq (-21t0 35 ° C).

Salinity is PSS-78.

Density is calculated based on the equation of state for seawater (EOS80).

The formulas for the computation of salinity, density, potential temperature,
specific volume anomaly, and sound velocity were obtained from " Algorithms
for computation of fundamental properties of seawater”, by N.P. Fofonoff and
R.C Millard Jr.; Unesco technical papersin marine science #44, 1983.

density =p=p(st,p)

[kg/m?]

(density of seawater with salinity s, temperature t, and pressure p)

Sigma-theta=Go=p (S, (s t, p, 0), 0) - 1000 [kg/m?|

Note:

See SEASOFT-DOS manual for
details on SEACALC - this module
is not yet available in the Windows
version of the software.

Sigma-1=0,=p (s (s, t, p, 1000), 1000) - 1000 [kg/m?|
Sigma-2=0,=p (s (s, t, p, 2000), 2000) - 1000 [kg/m?|
Sigma-4=0,4=p (s (s, t, p, 4000), 4000) - 1000 [kg/m?|
Sigma-t=0,=p(s t,0)-1000 [kg/m?|

potential temperature[IPTS-68] =0 (s, t,p,pr) [°C]

potential temperature[ITS90] =0 (s, t, p, pr) / 1.00024 [°C]

(Potential temperature is the temperature an element of seawater would have if
raised adiabatically with no change in salinity to reference pressure p..

DATA CONVERSION, DERIVE, and SEACALC use areference pressure of
0 decibars).
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potential temperature anomaly =
potential temperature - a0 - al x salinity
or

potential temperature - a0 - al x Sigma-theta
(a0, a1, and the selection of salinity or sigma-theta are user-input.)

ther mosteric anomaly = 10° ((1000/(1000 + G,)) - 0.97266) [10® m3/kg]
specificvolume= V(s t,p) = Up [m?kg]

specific volume anomaly = 3= 10%(V(s, t, p) - V(35,0,p))  [10®m%kg]

p=p
geopotential anomaly =10* X~ (8xAp) [J/kg] = [m?/s?]
2pp=0

dynamic meter s = geopotential anomaly / 10.0
(1 dynamic meter = 10 Jkg;
(Sverdup, Johnson, Flemming (1946), UNESCO (1991)))

44.660
oxygen oles/kg] = oxygen [ml/l
ygen [um | Sigma.- 8+ 1000 ygen [mi/]
p=p
> (Apxavgsv)
. App=min
aver age sound velocity = [m/s]
p=p
A
Ap,p=min p

(Average sound velocity isthe average from the surface to the current CTD
depth. The average is calculated on the downcast only. The first window
begins when pressure is greater than the minimum specified pressure and
salinity is greater than the minimum specified salinity. The average is updated
when both the change in pressure and change in time are greater than the
respective specified window sizes. The average sound velocity within the
window isavgSV.)

Surface

> Minimum specified pressure and salinity Spressure and C(\e/l?)rceilt%/e sound
¢ time window ¢ avgsv

Average sound

>pressure and avgSV velocity
time window

Derivative variables (doc/dt, descent rate, and accel eration) are computed by
looking at data centered around the current data point with a time span equal to
window size and using alinear regression to determine the slope.
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DERIVE has the following /x parameter when running from the Run Options
dialog box, from the command line, or with batch file processing:

/X PARAMETER | DESCRIPTION

Ixderive:pump For SBE 911plus, do not output scansiif
pump status = off.

See Appendix |: Run Options, Command Line Operation, and Batch File Processing for details on
using parameters.

DERIVE adds the following to the data file header:

LABEL DESCRIPTION

Derive date Date and time that module was run.
Derive in Input .cnv and .con files.
Derive_oxygen coeff Soc, Bac, tcor, peor, tau, wt

Derive_time window_docdt | Window size for oxygen doc/dt
calculation (seconds).

Derive_time window_dzdt | Window size for descent rate and acceleration
calculation (seconds).
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FILTER
L FILTER runs alow-pass filter on one or more columns of data. A low-pass
I o filter smoothes high frequency (rapidly changing) data. To produce zero phase
I/ (no time shift), the filter isfirst run forward through the data and then run
W backwards through the data. This removes any delays caused by the filter.
v
Filtered | Typically, only conductivity and pressure data are filtered. Two time constants
Data ! can be specified, so conductivity and pressure can be filtered with different
\ | . time constantsin one run of FILTER. Typical time constants for the
S N ggg”a' SBE 9plus are 0.03 seconds for conductivity and 0.15 seconds for pressure.
Time The Data Setup tab in the dialog box looks like this:
i Dpore el
Note: : .
The File Setup tab and FeSonp Dotn 5010 | Header View |
Header View tab are similar Low pash Whet & time corniit b o7 - . - |
for all modules; see Section 2: L — wkhl > Desired filter time constants
SBE Data Processing L el
Installation and Use. P

Select which variables to apply
filter to, and which time constant
to use for each variable.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \

on File Setup tab shows
Hiar Proceas | Est | Canosl

Processing complete when done.

The Specify Filters dialog box looks like this:

Specify Filters Ed I

“ariabla Marme furit] Filter Tipe:
 Temperature [|TS-90. deg ] Hiane
Carductivity [S/m] Nore -
Dsygen Current, Beckman/vS] [ud] Mg -
Dwpgen T_amp_a,eib.ué:_-ﬁ_ggkﬂahﬁ 5l [dea C] Mahe -
‘Orygen, Beckman/YS! [el/] Mane iz
Freszaung,; ngiquaitg_[dh] Maore *
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FILTER: Formulas

For a low-pass filter with time constant I':

I'=1w o =2xnf

T = sampleinterval (seconds)

S=1/T

Laplace transform of the transfer function of alow-pass filter (single pol€)
with a time constant of I" seconds is:

1
O T

Using the bilinear transform:

A 2@zh 2(z-1)
S = Farz5 T 7@
HE) zt+1
2= 2@-1) 2 1-27TS,
Y TS, "o 11+ (Teams ) 2}
2
1 1 Ts
If a= b=
TS TS
Then H@= Y@ - a@"+)
' X(2) (1+bz)

Where z * is the unit delay (one scan behind).

y[N] = current output
y[N-1] = previous output

X[N] = input data (current scan)
X[N-1] = previous input data (from previous scan)

Y (1+bzh)=X@az'+1)
YIN] + by[N-1] = ax[N-1] + ay[N-1]
YIN] = a(x[N] + x[N-1]) - by[N-1]

Example: Time constant = 0.5 second, sample interval = 1/24 second

1

A= @v2v05%24) ~ (@v2a) 00
1-24

B=(1-2*05*24)a= — — =-092
1+24

FILTER adds the following to the datafile header:

LABEL DESCRIPTION
Filter date Date and time that module was run.
Filter in Input .cnv file.

Filter low pass tc A

Time constant for filter A.

Filter low-Pass tc B

Time constant for filter B.

Filter low pass A vars

List of variables filtered with time constant A.

Filter low pass B vars

List of variables filtered with time constant B.
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LOOP EDIT
LOOP EDIT marks scans bad by setting the flag val ue associated with the
scan to badflag in input .cnv files that have pressure slowdowns or reversals.
The badflag value is documented in the input .cnv header.
Not The Data Setup tab in the dialog box looks like this:
ote:

The File Setup tab and
Header View tab are similar B2 Leop Edit M=1

for all modules; see Section 2: Fia Qpions  Help Minimum velocity type: o
SBE Data Processing » Fixed minimum velocity - If CTD velocity is less

; Fia Sehup  Dhéla Sehup | Hesde: Wiew | than specified Minimum CTD Velocity or
Installation and Use. ) pressure is not greater than previous maximum
M welociy pe LTI =l pressure, scan is marked with badflag.
» Percent of mean speed - For each scan, mean
Wik 10 welachy el Jo 5 speed over last Window Size seconds is
wlindow size 5] T computed. If CTD velocity is less than specified
Percent of Mean Speed, or if pressure is not
Peicénl of maar ipesd | greater than previous maximum pressure, scan

is marked with badflag. Minimum CTD Velocity is

b Btk stas marioad bad used to evaluate data points in first time window.

« If selected, scans previously
marked with badflag (for
example, in a previous run
of LOOP EDIT) will not
be evaluated.

« If not selected, scans
previously marked with
badflag will be reevaluated,
and scan’s flag will be Return to SBE Data Processing window.
reset accordingly. « If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status
field on File Setup tab shows \ I

Processing complete when done. Py e I FTI ¢ i I

LOOP EDIT adds the following to the data file header:

LABEL DESCRIPTION

Loopedit_date Date and time that module was run.
Loopedit_in Input .cnv file.

Loopedit_minVelocity If Fixed Minimum Velocity was selected -

minimum CTD velocity for good scans;
scans with velocity less than this are marked
with badflag.

Loopedit_percentMeanSpeed | If Percent of Mean Speed was selected -
minimum CTD velocity for first time
window, window size, and percent of mean
speed for good scans; scans that do not meet
this criteria are marked with badflag.
Loopedit_excl bad scans If yes, do not eval uate scans marked with
badflag in a previous run of LOOP EDIT.
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WILD EDIT

Note:

WILD EDIT marks individual data
(for example, a conductivity value)
with badflag, but does not mark the
entire scan (which may include other
data that is valid, such as
temperature, pressure, etc.).

Note:

The File Setup tab and
Header View tab are
similar for all modules;
see Section 2:

SBE Data Processing
Installation and Use.

The Data Setup tab in the dialog box looks like this:

= Wild Edit
Ede  Optiors  Hsip

=10 x|

Fie St Data Setup | Header View |

Stardand desdstiorn for pacs one

If selected, data from
scans marked with
badflag in LOOP EDIT
will not be used in
calculating mean and
standard deviation.

Sharwdad denalionre ke pass b
Soams per block.

Fasep clala widen ths cistanca ol theemman. I~

—

WILD EDIT markswild pointsin the data by replacing the data value with
badflag. The badflag value is documented in the input .cnv header.

WILD EDIT’ s agorithm requires two passes through the data: the first pass
obtains an accurate estimate of the data’ s true standard deviation, while the
second pass replaces the appropriate data with badflag.

flon

Select which variables
to run WILD EDIT on.

St Wild E it Vasiables . |

Begin processing
data. Status field on
File Setup tab shows
Processing complete
when done.

Do not flag data within this distance of mean,
even if it falls outside specified standard
deviation. Typically, leave at 0. May need to use
if data is very quiet (for example, a single bit
change in voltage may cause data to fall outside
specified standard deviation and be marked bad).
A typical sequence for using parameter follows:
1. Run WILD EDIT for all desired variables, with

2. Compare output to input data. If a variable’s

parameter set to 0.

data points that are very close to mean were

set to badflag:

A.Rerun WILD EDIT for all other variables,
leaving parameter at O and overwriting
output file from Step 1.

B. Rerun WILD EDIT for quiet variable only,
setting parameter to desired value to
prevent flagging of data close to mean.

Starl Process I

T & ]

Cancal

WILD EDIT operates

as follows:

1. Compute mean and
standard deviation of
data in block
(specified by Scans
per Block) for each
selected variable.
Temporarily flag
values that differ from
mean by more than
standard deviations
specified for pass 1.

2. Recompute mean and
standard deviation,
excluding temporarily
flagged values. Mark
values that differ from
mean by more than
standard deviations
specified for pass 2 by
replacing data value
with badflag.

3. Repeat Steps 1 and 2
for next block of
scans.

« If last block has less
than specified
number of scans,
use data from
previous block to fill
in block.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

If the datafile is particularly corrupted, you may need to run WILD EDIT
more than once, with different block sizes and number of standard deviations.

WILD EDIT adds the following to the data file header:

LABEL DESCRIPTION
Wildedit date Date and time that module was run.
Wildedit_in Input .cnv file.

Wildedit_passl nstd

Number of standard deviations for pass 1 test.

Wildedit_pass?2 nstd

Number of standard deviations for pass 2 test.

Wildedit_pass2_mindelta

Keep data within this distance of mean.

Wildedit_npoint

Number of pointsto include in each test.

Wildedit vars

List of the variables tested for wild points.

Wildedit_excl_bad scans

standard deviation.

If yes, values in scans marked with badflag (in
LOOP EDIT) will not be used to determine
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WINDOW FILTER
WINDOW FILTER provides four types of window filters and a median filter
for data smoothing of .cnv files:
*  Window filters calculate a weighted average of data values about a center
point and replace the data value at the center point with this average.
*  The median filter calculates a median for data val ues about a center point
and replaces the data val ue at the center point with the median.

The File Setup tab and The Data Setup tab in the dialog box looks like this:

Header View tab are similar - —
for all modules; see Section 2: -
SBE Data Processing Cle- Qpteret - fiop

Installation and Use. Fia Gehp Tats Sakp |Hm Wi |

Irdervnl betwaman woar, seoonds = 0 416RET

If selected, data
from scans marked
with badflag in
LOOP EDIT will not fipesify Files...
be used. I.“)dm I

|_—"F Exchuds scan: nkadtad

Select which variables to run
WINDOW FILTER on, and
specify the filters.

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

Begin processing data. Status field \ |
on File Setup tab shows é—l
Processing complete when done. Sladi Protess s e |

The Specify Window Filters dialog box looks like this:

Wbl Hiars i Filet Typs Facamstary Demia |
Precrue, Dipauariz [db] Ganden 8 5, 1.000. 0o Select none, boxcar, cosine,
Terpassturs 17530, dag [] Hore  |E gaussian, median, or triangle filter.
Tenpasshue, 2 J TS50 dagiT] - A dialog box appears to enter
[ = applicable filter parameters, which
Cord i’-‘!.l-”ﬁ-"ﬂ then display in Parameters column.
Dherety [spmisrtheta, Kgin™J]
iy [FEL| Hone . |
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Maghnitude

Window Filters: Descriptions and Formulas

Shape and length define filter windows:

*  WINDOW FILTER provides four window shapes. boxcar, cosine,
triangle, and gaussian.

e The minimum window length is 1 scan, and the maximum is 511 scans.
Window length must be an odd number, so that the window has a center
point. If awindow length is specified as an even number, WINDOW
FILTER automatically adds 1 to make the length odd.

The window filter calculates a weighted average of data values about a center
point, using the following transfer function:

L2

y(n) = 2 w(k) x(n-k)

k=-L/2

The figure below shows the impul se response of each of the four filter types
for afilter of length 17 scans. The impulse response of afilter is obtained by
filtering a data set that has zeros everywhere except one data value that is set
to 1.

Boxcar Cosine

Triangle Gaussian

Time
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Note:

In the window filter equations:

« L =window length in scans,
(always an odd number)

* n =window index, -L/2 to +L/2,

with 0 the center point of
the window
« w(n) = set of window weights

The window filtering processis similar for all filter types:
1. Filter weights are calculated (see the equations below).
2. Filter weights are normalized to sum to 1.

*  When abad data point is encountered (scan marked with badflag if
exclude scans marked bad was selected or data value marked with
badflag), the weights are renormalized, excluding the filter element
that would operate on the bad data point.

Boxcar Filter

1 L-1 L-1

w(n) =

Cosine Filter
win)=1 forn=0

nxTtt L-1 L-1
w(n) = cos forn= - R I

L+1 2 2

Triangle Filter

wn)=1 forn=0

n L-1 L-1
In forn= - ..

K 2 2
L-1

2

w(n) =

whereK = +1

Gaussian Filter

phase = offset (sec)

sample interval (sec)
2

sample rate
scale=1og(2) x ff 2 x
half width (scans)

) - e—phasex phase x scale

w(n forn=0

, L-1 L-1
w(n) = e ("-phasd)” xsle gor g = L1

The gaussian window has parameters of halfwidth (in scans) and offset (in
time), in addition to window length (in scans). These extra parameters allow
datato be filtered and shifted in time in one operation. Halfwidth determines
the width of the gaussian curve. A window length of 9 and halfwidth of 4
produces a set of filter weights that fills the window. A window length of 17
and halfwidth of 4 produces a set of filter weights that fills only half the
window. If the filter weights do not fill the window, the offset parameter may
be used to shift the weights within the window without clipping the edge of the
gaussian curve.
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Pressure

Example: Window length is 33 scans and halfwidth is 4 scans. Offset is
-3 secondsin left curve, O in middle curve, and +3 seconds in right curve.

Shifted 0 seconds
/

-

1

1
1
1
1

Shifted — by

' ™ shifted
-3 seconds |

+3 seconds

Magnitude

1
1
1
1
1
1
1
1
1
1
1
1
1
1

|
T | P A -
3 6 9 12 15 18 21 24 27 Time

Note that the window length in the exampleislarger than the halfwidth. This
allows the complete gaussian curve to be expressed in the window when the
offset parameter shifts the curve forward or backward in time. If the halfwidth
was larger, the trailing edge of the -3 second offset curve would be truncated
and the leading edge of the +3 second curve would be truncated. The offset
parameter moves the gaussian shape of the window weights forward or
backward in time. Since the weighted average is calculated for adatavaluein
the center of the window, this has the effect of shifting the data that the filter is
operating on forward or backward in time relative to the other datain thefile.
This capability allows filtering and time shifting to be done in one step.

Median Filter: Description
The median filter is not a smoothing filter in the same sense as the window
filters described above. Median filtering is most useful in spike removal.

A median value is determined for a specified window, and the data value at the
window’s center point is replaced by the median value.

L
i

2 ' i %
TRy i T
: % i <
; 4 | /
o
] T S
7 Unfiltered Data T

@
“Median-Filtered Data,
/ window length 17
Salinity

LU S B
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WINDOW FILTER has the following /x parameter when running from the
Run Options dialog box, from the command line, or with batch file processing:

IXx PARAMETER

DESCRIPTION

Ixwrilter:diff

Output difference between original and filtered value
instead of outputting filtered value.

See Appendix |: Run Options, Command Line Operation, and Batch File Processing for details on

using parameters.

WINDOW FILTER adds the following to the data file header:

LABEL DESCRIPTION

Wrilter date Date and time that module was run.

Wfilter in Input .cnv file.

Wrilter_excl | If yes, valuesin scans marked with badflag in LOOP EDIT
bad scans will not be used.

Wfilter _action | Datachannel identifier, filter type, filter parameters.
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Section 9: Data Display and Plotting

Modules

All display and plotting is performed on converted datafrom a.cnv file.

M odule Name

Module Description

ASCII OUT

Output data portion and/or header portion from .cnv file
to an ASCII file (.asc for data, .hdr for header).

Useful for exporting converted data for processing by
other (non-Sea-Bird) software.

CONTOUR

Generate density contours to overlay on TS plots. See
SEASOFT-DOS manual for details- this module is not
yet available in the Windows version of the software.

SEAPLOT

Plot data (C, T, P aswell as derived variables). Plots can
be screen dumped to a printer or plotted on an HP pen
plotter or HP LaserJet I11. Note that SEAPLOT can plot
data at any point after DATA CONVERSION has been
run. See SEASOFT-DOS manual for details - this
moduleis not yet available in the Windows version of
the software.
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ASCII OUT

Note:

The File Setup tab and
Header View tab are similar
for all modules; see Section 2:
SBE Data Processing
Installation and Use.

If selected, scans
marked with badflag in
LOOP EDIT will not be
output in data file.

\E Eschade scans marked bad

If selected, a column is
inserted before the first
column of data, with
specified column name
and data value.

Select which variables to
include in output data file.

Begin processing data. Status field
on File Setup tab shows
Processing complete when done.

ASCII OUT outputs the header portion and/or the data portion of a converted

datafile (.cnv).

*  Thedataportion iswritten in ASCII engineering unitsto a.asc file, and
may be useful if you are planning to export converted data for processing
by other (non-Sea-Bird) software.

*  The header portion is written to a.hdr file.

The Data Setup tab in the dialog box looks like this:

Eide Opliors  Help

If columns are labeled at top of each

Fle Solup  Daln Sehup | Haade Viaw | page, form feed character is inserted
sEssLiiREENEE after selected number of lines/page.
W Dutoud beader b Lives pet page [5)7 1
' Dutpal dala e

Column label for output data file: Top of the

file, Top of each page, or No column labels.
I
|""-" CORETE |atret /]' Column separator for output data file:

Cokasn separahn Iﬂ/ space, tab, semi-colon, or colon.
5 pace

Auben days conmertion lormal | ), cags =1 IDate format for output data file
(applicable if date selected as
= Bt o an output variable)
/ 'am

Fasl cobamn rase |

Fas! cobmmn value |
If selected, all occurrences of badflag in input file

I FAeplate bad g ————————— (occurrences in flag column as well as in data columns)
are replaced with specified value in output file. This

Hew berd flag vabae [5 350029 may be useful for plotting purposes, as SBE Data

Processing uses a very small number (-9.990e-29) for
badflag, which looks like 0 in a plot.

|

Start Process [ ey | Coxs |
AN

AN

Return to SBE Data Processing window.

« If Confirm Program Setup Change was selected in Options menu - If you made
changes and did not Save or Save As, program asks if you want to save changes.

« If Confirm Program Setup Change was not selected in Options menu - This button
says Save & Exit. If you do not want to save changes, use Cancel button to exit.

ASCII OUT does not add anything to the data file header. The output header
(.hdr) file contains the header from the input (.cnv) file.
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Appendix I: Run Options, Command Line
Operation, and Batch File Processing

SBE Data Processing Run Options

Note:

The default program setup (.psu)
file is the last saved .psu file for
the module. PostProcSuite.ini,
located in the Windows directory,
contains the location and file name
of the last saved .psu file for

each module.

Run options can be used to assist in automating processing, by overriding
information in an existing program setup (.psu) file or designating a different
psufile.

Access the Run Options dialog box by selecting Run Optionsin the
SBE Data Processing window’ s Run menu:

B2 SBE Data Proceszing M=l E2 I
| Bun Configurs  Help

2 ASCI ..

23 ASCH Dut..

4. Bin Aiverage...

5 Buoyancy.

B. Cell Thermal Mass...

7. Data Conwersion...

_B.. Drenve

3 Filter..,

10, Losp Edit.

11 Mark Sean..

13 Section .

14 Spit..

15. Strip:..

16 Translate...

AE, il Edit...

18 Wihdow Fiter...

Fiuin Optians, ..
Enib

The Run Options dialog box looks like this:

Opters |

I Autastatt

ok ] coneel |




Appendix |: Run Options, Command Line Operation, and Batch File Processing

The option parameters are:

Parameter Description

[/cString Use String as instrument configuration (.con) file.

String must include full path and file name.

Note: If using this parameter, you must also specify input
file name (using /iString).

/iString Use String as input file name. String must include full path

and file name.

The /iString option supports standard wildcard expansion:

«  ?matches any single character in specified position
within file name or extension

« * matches any set of characters starting at specified
position within file name or extension and continuing
until end of file name or extension or another specified

character
/oString Use String as output directory (not including file name).
[fString Use String as output file name (not including directory).
[aString Append String to output file name (before file name
extension).
/pString Use String as Program Setup (.psu) file. String must

include full path and file name.

/xModule:String |Use String to define an additional parameter to pass to
Module. Not all modules have x parameters; see module
descriptions for details. If specifying multiple x parameters,
enclose in double quotes and separate with a space; do not
specify x parameter more than once.

Example: Run DATA CONVERSION, telling it to skip
first 1000 scans and also run WINDOW FILTER, telling it
to output difference between original and filtered value:

/x* datcnv:skip1000 wfilter:diff” Correct

Note:

If you do not select Auto Start,
when you select a module the
module dialog box appears,
allowing you to review the selected
input files and data setup before
beginning processing.

Ixdatcnv:skipl000 /xwfilter:diff Incorrect
If specifying multiple parameters, insert a space between each parameter
in thelist.

Example: You set up and saved .psu filesfor FILTER, LOOP EDIT, BIN
AVERAGE, and DERIVE within each modul€' s dialog box, and ran each
modul e successively. The input and output file namesin all the .psu files were
the same - c:/1st/test.cnv (this has the effect of overwriting the module input
with the module output).
Y ou now want to run each process again, using a different input and output
file - c:\2nd\test1.cnv. Y ou enter the following in SBE Data Processing’'s
Run Options dialog box:

fic:\2nd\testl.cnv /ftestl.cnv /oc:\2nd

When you pull down on the Run menu and select FILTER, you seein the
FILTER dialog box that the program substituted c:\2nd\test1.cnv for
c:\1st\test.cnv as the input data and output data path and file. Similarly,
testl.cnv is shown as the input and output datafile in al the modules. Y ou can
run each process rapidly in succession, without needing to enter the new path
and file name individually in each module.

Auto Start (for running a post-processing modul€)

Select this and then select the desired post-processing module to have

SBE Data Processing automatically run the module with the last saved setup

parameters (defined by the .psu file) and any entered Run Options.

» If you select Auto Start, a Run Minimized selection box appears. If
selected, SBE Data Processing minimizes its window while processing the
data, allowing you to do other work on the computer. When processing is
complete, the SBE Data Processing window reappears.

85



Appendix |: Run Options, Command Line Operation, and Batch File Processing

Command Line Operation

The following modules can be run from the command line (default location for
all fileslisted below is c:/Program Files/Sea-Bird/DataProcessing-Win32):

Module Executable File Name
ALIGN CTD AlignCTDW.exe
ASCII IN ASCIl InW.exe
ASCII OUT ASCII OutW.exe
BIN AVERAGE BinAvgW.exe
BUOYANCY BuoyancyW.exe
CELL THERMAL MASS CellTMW.exe
DATA CONVERSION DatCnvW.exe
DERIVE DeriveW.exe
FILTER FilterW.exe
LOOPEDIT L oopEditW.exe
MARK SCAN MarkScanW.exe
ROSETTE SUMMARY RosSumW.exe
SECTION SectionW.exe
SPLIT SplitW.exe
STRIP StripW.exe
TRANSLATE TransW.exe
WILD EDIT WildEditW.exe
WINDOW FILTER W_FilterW.exe
Note: Command line parameters can be used to override existing information in the
The default program setup (.psu) .psu file. The command line parameters are:
file, used when running a module Parameter Description
from the command line, is the last /cString Use String as instrument configuration (.con) file. String

saved .psu file for the module. must include full path and file name. Note: If using this

PostProcSuite.ini, located e . .
in the Windows directory, contains ﬁg{;\irggt)er, you must also specify input file name (using

a list of the location and file name
of the last saved .psu file for
each module.

/iString Use String as input file name. String must include full path

and file name.

This parameter supports standard wildcard expansion:

«  ?matches any single character in specified position
within file name or extension

« * matches any set of characters starting at specified
position within file name or extension and continuing
until end of file name or extension or another specified

character
/oString Use String as output directory (not including file name).
[fString Use String as output file name (not including directory).
/aString Append String to output file name (before file name
extension).
/pString Use String as Program Setup (.psu) file. String must

include full path and file name.

/xModule:String |Use String to define an additional parameter to pass to
Module. Not all modules have x parameters; see module
descriptions for details. If specifying multiple x parameters,
enclose in double quotes and separate with a space.
Example: Run DATA CONVERSION from command line,
telling it to skip first 1000 scans:

datcnvw.exe /xdatcnv:skip1000

/s Start processing now.
If specifying multiple parameters, insert a space between each parameter
in thelist.
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Example: The specified input file directory contains test.dat, test1.dat, and
test2.dat. Select Run in the Windows Start menu. The Run dialog box appears.

fum K E

Note: Ty the rsme of = paogram, folder. document, o Inbemet
If you have not modified your repoaz . snd srakoee: vl open it o oo

autoexec.bat file to put the .exe
files in the path statement, specify e |l]-e-‘clr-w sum fat dal /e j
the full path of datcnvw.exe in the

Run dialog box. [ | Cwed | Broe |

For the command line shown (datcnvw.exe /itest*.dat /s), SBE Data
Processing will process test.dat, testl.dat, and test2.dat using DATA
CONVERSION. If the ? wildcard symbol is used (datcnvw /itest?.dat) instead
of the*, DATA CONVERSION will process only testl.dat and test2.dat.
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Batch File Processing

Traditional DOS batch file processing cannot be used with the 32-bit post-
processing modules because Win 95/98/NT will start the second process
before the first processiis finished. The program SBEBatch.exe (default
location c:/Program Files/Sea-Bird/SBEDataProcessing-Win32) or the
Windows Scripting Host can be used to process a batch file to automate data
processing tasks. The format for SBEBatch is:

shebatch filename parameters

The parameters are referenced in the batch file in the same way asthe DOS
batch file, using the percent sign (%) followed by numbers 1 through 9. %1 in
the batch fileis replaced by the first command line parameter, %2 in the batch
file isreplaced by the second command line parameter, and so on until %69.

Each line in the batch file contains the process name followed by command
line arguments. The process names are:

M odule Process Name
ALIGN CTD AlignCTD
ASCII IN ASCIlIn
ASCII OUT ASCIIOut
BIN AVERAGE BinAvg
BUOYANCY Buoyancy
CELL THERMAL MASS CdlT™M
DATA CONVERSION DatCnv
DERIVE Derive
FILTER Filter
LOOP EDIT L oopEdit
MARK SCAN MarkScan
ROSETTE SUMMARY RosSum
SECTION Section
SPLIT Split
STRIP Strip
TRANSLATE Trans
WILD EDIT WildEdit
WINDOW FILTER WFilter
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Note:

The default program setup (.psu)
file, used when running a module
from the command line, is the last
saved .psu file for the module.
PostProcSuite.ini, located in the
Windows directory, contains a list
of the location and file name of
the last saved .psu file for

each module.

Parameters specified in the batch file can be used to override existing
information in the .psu file. These parameters are:

Par ameter Description

/cString Use String as instrument configuration (.con) file.

String must include full path and file name.
Note: If using this parameter, you must also specify input
file name (using /iString).

/iString Use String as input file name. String must include full path

and file name.

This parameter supports standard wildcard expansion:

«  ?matches any single character in specified position
within file name or extension

« * matches any set of characters starting at specified
position within file name or extension and continuing
until the end of file name or extension or another
specified character

/oString Use String as output directory (not including file name).

[fString Use String as output file name (not including directory).

[aString Append String to output file name (before file name
extension).

/pString Use String as Program Setup (.psu) file. String must

include full path and file name.

/xModule:String |Use String to define an additional parameter to pass to

Module. Not all modules have x parameters; see module
descriptions for details. If specifying multiple x parameters,
enclose in double quotes and separate with a space.
Example: Run DATA CONVERSION, telling it to skip
first 1000 scans:  /xdatcnv:skip1000

Minimize the SBE Data Processing window while
processing the data, allowing you to do other work on the
computer.

If specifying multiple parameters, insert a space between each parameter
in thelist.

To process data using a batch file:

1.

2.

Run each software module, entering the desired choicesin the File Setup
and Data Setup dialog boxes. Upon completing both dialog boxes, press
Save or Save Asin the File Setup dialog box. The configuration is stored
in the Program Setup File (.psu).

Create a batch file to process the data.

Following are two examples of typical batch files.

Example 1 — Process Single File, and Save All I ntermediate Files
The datafileis c:\legl\cast5.dat, and the .con fileis c:\legl\cast5.con.

1.

Set up each software module, entering desired choicesin Data Setup
dialog boxes. In the File Setup dialog boxes, delete the output file name
(this allows program to base output file name on input file name and any
appended text), and set the output file path as c:\legl.
Create a batch file named prcast.txt in ¢c:\legl, which contains:

datcnv /ic\legl\%l.dat /cc:\leg1\%1.con /a%2

wildedit /ic:\leg1\%1%2.cnv /asl

filter /ic\leg1\%61%2sl.cnv /as2

loopedit /ic:\leg1\%1%2s1s2.cnv /as3

derive /i%c:\leg1\1%2s1s2s3.cnv /cc:\leg1\%1.con /asA
Select Run in the Windows Start menu. The Run dialog box appears.
Type in the program name and parameters as shown:

shebatch c:\legl\prcast.txt cast5 testl

(batch filename is c:\legl\prcast1.txt; parameter %1 is cast5;

parameter %2 is test1)
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The datais processed as follows (all input and output filesarein c:\legl):

Module Input File(s) Output File
DATA CONVERSION |cast5.dat castbtestl.cnv
(datcnv) castb.con
WILD EDIT (wildedit) |castbStestl.cnv castbtest1sl.cnv
FILTER (filter) castbtest1sl.cnv castbtest1s1s2.cnv
LOOP EDIT (loopedit) |castStest1s1s2.cnv castbtest1s1s2s3.cnv
DERIVE (derive) castbtest1s1s2s3.cnv  |castStest1s1s2s3s4.cnv
castb.con

Example 2 — Process Several Files, and Overwrite All I ntermediate Files
Process all datafilesin c:\legl. The datafiles are c:\legl\cast1.dat and

c:\legl\cast2.dat, and the .con fileis c:\legl\cast.con.
1

Set up each software module, entering desired choicesin Data Setup
dialog boxes. In the File Setup dialog boxes, delete the output file name
(this allows program to base output file name on input file name and any
appended text). Set the output file path as c:\legl.

Create a batch file named prallcasts.txt in c:\legl, which contains:
datcnv /i%21\*.dat /c%1\cast.con /0%1
wildedit /i%21\*.cnv /01%
filter /i%1\*.cnv /01%
loopedit /i%1\*.cnv /01%
binavg /i%1\*.cnv /aavg /0%1

derive /i%1\*avg.cnv /c%l\cast.con /0%l

Select Run in the Windows Start menu. The Run dialog box appears.
Type in the program name and parameters as shown:
shebatch c:\legl\prallcasts.txt c:\legl
(batch filenameis c:\legl\prallcasts.txt; parameter %1 is c:\legl)

The datais processed as follows (all input and output filesarein c:\legl):

Module Input File(s) Output File
DATA CONVERSION (datcnv) castl.dat castl.cnv
cast2.dat cast2.cnv
cast.con
WILD EDIT (wildedit) castl.cnv castl.cnv
cast2.cnv cast2.cnv
FILTER (filter) castl.cnv castl.cnv
cast2.cnv cast2.cnv
LOOP EDIT (loopedit) castl.cnv castl.cnv
cast2.cnv cast2.cnv
BIN AVERAGE (binavg) castl.cnv castlavg.cnv
cast2.cnv cast2avg.cnv
DERIVE (derive) castlavg.cnv castl.cnv
cast2avg.cnv cast2.cnv
cast.con
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Appendix Il: Configure File Format

Shown below is aline-by-line description of the .con file contents, which can
be viewed in atext editor.

Li ne | Contents

1 | Conductivity sensor serial nunber

2 | Conductivity M A B, C, D CPCOR

3 | Conductivity cell _const, series_r, slope, offset, use GH J coefficients?

4 | Tenperature sensor serial nunber

5 | Tenperature FO, A, B, C, D, slope, offset, use GH J coefficients?

6 | Secondary conductivity sensor serial nunber

7 | Secondary conductivity M A B, C D PCOR

8 | Secondary conductivity cell_const, series_r, slope, offset, use GH J coefficients?

9 | Secondary tenperature sensor serial nunber

10 | Secondary tenperature FO, A, B, C, D, slope, offset, use GH J coefficients?

11 | Pressure sensor serial nunber

12 | Pressure T1, T2, T3, T4, T5

13 | Pressure C1 (Al), C2 (A0), C3, C4 (A2) - paranmeters in parentheses for strain gauge sensor

14 | Pressure D1, D2, slope, offset, pressure sensor type, AD590 M AD590 B

15 | Oxygen (Becknman/ YSI type) sensor serial nunber

16 | Oxygen (Beckman/ YSI type) M B, K C, SOC, TCOR

17 | Oxygen (Becknman/ YSI type) WI, PCOR, TAU, BCC

18 | pH sensor serial nunber

19 | pH sl ope, offset, VREF

20 | PAR |ight sensor serial nunber

21 | PAR cal const, multiplier, M B, surface cc, surface_r, offset

22 | Transm ssoneter (SeaTech, Chel sea Al phaTracka, WET Labs Cstar) sensor serial nunber

23 | Transm ssoneter (SeaTech, Chel sea Al phaTracka, WET Labs Cstar) M B, path length

24 | Fl uoronet er SeaTech sensor serial nunber

25 | Fl uoronet er SeaTech scal e factor, offset

26 | Tilt sensor serial nunber

27 | Tilt XM XB, YM YB

28 | ORP sensor serial nunber

29 | ORP M B, offset

30 | OBS/ Nephel onet er D&A Backscatterance sensor serial nunber

31 | OBS/ Nephel onet er D&A Backscatterance gain, offset

32 | Aitineter scale factor, offset, hyst, mn pressure, hysteresis

33 | Mcrostructure tenperature sensor serial nunber

34 | Mcrostructure tenperature pre.m pre_b

35 | Mcrostructure tenperature num denom A0, Al, A3

36 | Mcrostructure conductivity sensor serial nunber

37 | Mcrostructure conductivity A0, Al, A2

38 | Mcrostructure conductivity M B, R

39 | Nunber of external frequencies, nunber of bytes, nunber of voltages, instrunent type, conputer
interface, scan rate, interval, store systemtinme?

40 | Data format channels 0 - 9

41 | Data format channels 10 - 19

42 | Data format channels 20 - 39

43 | SBE 16: use water tenperature?, fixed pressure, fixed pressure tenperature

44 | Fi rmnar e versi on

45 | SBE 911pl us: nunmber of frequencies from SBE 9, nunber of frequencies to be suppressed, nunber
of voltages to be suppressed, voltage range, add surface PAR voltage?, NMVEA interface
install ed?, include | ONsensors?

46 | OBS/ Nephel onet er | FREMER sensor serial nunber

47 | OBS/ Nephel onet er | FREMER VMD, VDO, DO, K

48 | OBS/ Nephel oret er Chel sea sensor serial nunber

49 | OBS/ Nephel oet er Chel sea cl ear water voltage, scale factor

50 | ZAPS sensor serial nunber

51 | ZAPS m b

52 | Conductivity sensor calibration date

53 | Tenperature sensor calibration date

54 | Secondary conductivity sensor calibration date

55 | Secondary tenperature sensor calibration date

56 | Pressure sensor calibration date

57 | Oxygen (Beckman/ YSI type) sensor calibration date

58 | pH sensor calibration date

59 | PAR I'ight sensor calibration date

60 | Transm ssoneter (SeaTech, Chel sea Al phaTracka, WET Labs Cstar) sensor calibration date

61 | Fl uorometer (SeaTech) sensor calibration date
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62 | Tilt sensor calibration date

63 | ORP sensor calibration date

64 | OBS/ Nephel onet er D&A Backscatterance sensor calibration date

65 | Mcrostructure tenperature sensor calibration date

66 | Mcrostructure conductivity sensor calibration date

67 | | FREMER OBS/ nephel oneter sensor calibration date

68 | Chel sea OBS/ nephel oneter sensor calibration date

69 | ZAPS sensor calibration date

70 | Secondary oxygen (Beckman/YSl type) sensor serial nunber

71 | Secondary oxygen (Beckman/YS| type) sensor calibration date

72 | Secondary oxygen(Beckman/YSI type) M B, K, C SOC, TCOR

73 | Secondary oxygen(Beckman/ YSI type) WI, PCOR, TAU, BCC

74 | User polynomal 1 sensor serial nunber

75 | User polynomial 1 sensor calibration date

76 | User polyl A0, Al, A2, A3

77 | User polynom al 2 sensor serial nunber

78 | User polynomial 2 sensor calibration date

79 | User polynomal 2 A0, Al, A2, A3

80 | User polynom al 3 sensor serial nunber

81 | User polynonial 3 sensor calibration date

82 | User polynomial 3 A0, Al, A2, A3

83 | Dr. Haardt Chlorophyl| fluoronmeter sensor serial nunber

84 | Dr. Haardt Chlorophyll fluoroneter sensor calibration date

85 | Dr. Haardt Chlorophyl| fluoronmeter AO, Al, BO, B1l, which npdulo bit, gain range switching

86 | Dr. Haardt Phycoerythrin fluoroneter sensor serial nunber

87 | Dr. Haardt Phycoerythrin fluoroneter sensor calibration date

88 | Dr. Haardt Phycoerythrin fluoroneter A0, Al, BO, Bl1, which nodulo bit, gain range switching

89 | Dr. Haardt Turbidity OBS/ nephel oneter sensor serial nunber

90 | Dr. Haardt Turbidity OBS/ nephel oneter sensor calibration date

91 | Dr. Haardt Turbidity OBS/ nephel oneter A0, Al, B0, B1, which npdulo bit, gain range swi tching

92 | | ON oxygen sensor serial nunber

93 | | OW oxygen sensor calibration date

94 | | OWoxygen A0, Al, A2, A3, B0, Bl

95 | I OWsound velocity sensor serial nunber

96 | | OWsound velocity sensor calibration date

97 | |OWsound velocity A0, Al, A2

98 | Bi ospherical natural fluoronmeter sensor serial nunber

99 | Bi ospherical natural fluoroneter sensor calibration date

100 | Bi ospherical natural fluoroneter Cin, Al, A2, B

101 | Sea tech |1s6000 OBS/ nephel oneter sensor serial nunber

102 | Sea tech |1s6000 OBS/ nephel oneter sensor calibration date

103 | Sea tech |1s6000 OBS/ nephel oneter gain, slope, offset

104 | Fl uoronet er chel sea Aquatracka sensor serial nunber

105 | Fl uoronmeter chel sea Aquatracka sensor calibration date

106 | Fl uoroneter chel sea Aquatracka scale factor, slope, offset, Vacetone, VB (static), Viug/l

107 | Fl uoroneter turner sensor serial nunber

108 | Fl uoroneter turner sensor calibration date

109 | Fluoroneter turner scale factor, offset; or
turner-10au-005 full scale concentration, full scale voltage, zero point concentration

110 | Conductivity G H, I, J, ctcor, cpcor

111 | Tenperature F1, G H |, J

112 | Secondary conductivity G H, |, J, ctcor, cpcor

113 | Secondary tenperature F1, G H, |, J

114 | WET Labs AC3 beam transmi ssion transm ssoneter sensor serial nunber

115 | WET Labs AC3 beam transm ssion transm ssoneter sensor calibration date

116 | WET Labs AC3 beam transm ssion transm ssoneter Ch2o, Vh2o, Vdark, x, chlorophyll absorption
Kv, Vh2o, a"x

117 | WET Labs WETStar fluoroneter sensor serial nunber

118 | WET Labs WETStar fluoroneter sensor calibration date

119 | WET Labs WETStar Vbl ank, scale factor

120 | Primary conductivity sensor using g, h, i, j coefficients calibration date

121 | Prinmary tenperature sensor using g, h, i, j coefficients calibration date

122 | Secondary conductivity sensor using g, h, i, j coefficients calibration date

123 | Secondary tenperature sensor using g, h, i, j coefficients calibration date

124 | FGP pressure sensor #0 serial nunber

125 | FGP pressure sensor #0 calibration date

126 | FGP pressure sensor #0 scale factor, offset

127 | FGP pressure sensor #1 serial nunber

128 | FGP pressure sensor #1 calibration date

129 | FGP pressure sensor #1 scale factor, offset

130 | FGP pressure sensor #2 serial nunber

131 | FGP pressure sensor #2 calibration date

132 | FGP pressure sensor #2 scale factor, offset

133 | FGP pressure sensor #3 serial nunber

134 | FGP pressure sensor #3 calibration date
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135 | FGP pressure sensor #3 scale factor, offset

136 | FGP pressure sensor #4 serial nunber

137 | FGP pressure sensor #4 calibration date

138 | FGP pressure sensor #4 scale factor, offset

139 | FGP pressure sensor #5 serial nunber

140 | FGP pressure sensor #5 calibration date

141 | FGP pressure sensor #5 scale factor, offset

142 | FGP pressure sensor #6 serial nunber

143 | FGP pressure sensor #6 calibration date

144 | FGP pressure sensor #6 scale factor, offset

145 | FGP pressure sensor #7 serial nunber

146 | FGP pressure sensor #7 calibration date

147 | FGP pressure sensor #7 scale factor, offset

148 | OBS/ Nephel orret er seapoint turbidity neter sensor serial nunber
149 | OBS/ Nephel orret er seapoint turbidity neter sensor calibration date
150 | Primary OBS/ Nephel oneter seapoint turbidity neter gain, scale

151 | Secondary OBS/ Nephel oret er seapoint turbidity neter sensor serial nunber
152 | Secondary OBS/ Nephel onet er seapoint turbidity neter sensor calibration date
153 | Secondary OBS/ Nephel onet er seapoint turbidity neter gain, scale
154 | Fl uoronmeter Dr. Haardt Yell ow Substance sensor serial nunber

155 | Fl uoronmeter Dr. Haardt Yellow Substance sensor calibration date
156 | Fl uoronmeter Dr. Haardt Yell ow Substance A0, Al, BO, B1, which nodulo bit, gain range swtching
157 | Fl uoronmeter Chel sea M nitraka serial nunber

158 | Fl uoronmeter Chel sea M nitraka calibration date

159 | Fl uoronmeter Chel sea M nitraka vacetone, vacetonelO0, offset

160 | Seapoint fluoroneter serial nunber

161 | Seapoint fluoronmeter calibration date

162 | Seapoint fluoroneter gain, offset

163 | Primary Oxygen (SBE 43) serial nunber

164 | Primary Oxygen (SBE 43) calibration date

165 | Primary Oxygen (SBE 43) Soc, Tcor, offset

166 | Primary Oxygen (SBE 43) Pcor, Tau, Boc

167 | Secondary Oxygen (SBE 43) serial nunber

168 | Secondary Oxygen (SBE 43) calibration date

169 | Secondary Oxygen (SBE 43) Soc, Tcor, offset

170 | Secondary Oxygen (SBE 43) Pcor, Tau, Boc

171 | Secondary sea tech | s6000 OBS/ nephel oneter sensor serial nunber
172 | Secondary sea tech | s6000 OBS/ nephel ometer sensor calibration date
173 | Secondary sea tech | s6000 OBS/ nephel oneter gain, slope, offset
174 | Secondary Chel sea Transm ssoneter sensor serial nunber

175 | Secondary Chel sea Transmi ssoneter calibration date

176 | Secondary Chel sea Transmi ssoneter M B, path |ength

177 | Altimeter serial nunber

178 | Altimeter calibration date

179 | WET Labs AC3 serial nunber

180 | VET Labs AC3 calibration date

181 | Surface PAR serial nunber

182 | Surface PAR calibration date

183 | SEACATpl us tenperature sensor serial nunber

184 | SEACATpl us tenperature sensor calibration date

185 | SEACATpl us tenperature sensor A0, Al, A2, A3, slope, offset

186 | SEACATpl us serial sensor, scans to average, node

187 | Pressure (strain gauge with span TC) serial nunber

188 | Pressure (strain gauge with span TC) calibration date

189 | Pressure (strain gauge with span TC) ptenpA0, ptenpAl, ptenpA2, pTCAO, pTCAl, PTCA2
190 | Pressure (strain gauge with span TC) pTCBO, pTCB1, pTCB2, pAO, pAl, pA2, offset
191 | SBE 38 tenperature sensor serial nunber

192 | SBE 38 tenperature sensor calibration date

193 | Turner SCUFA fluoroneter serial nunber

194 | Turner SCUFA fluoroneter calibration date

195 | Turner SCUFA fluoroneter scale factor, offset, units, nx, nmy, b
196 | Turner SCUFA OBS serial nunber

197 | Turner SCUFA OBS cal i bration date

198 | Turner SCUFA OBS scal e factor, offset

199 | WET Labs ECO AFL fluoroneter serial nunber

200 | VET Labs ECO- AFL fluoroneter calibration date

201 | VET Labs ECO- AFL fl uoroneter vblank, scale factor

93




Appendix IlI: Software Problems

Appendix lll: Software Problems

Considerable effort has been made to test and check this software before its
release. However, because of the wide range of instruments that Sea-Bird
produces (and interfaces with) and the many applications that these
instruments are used in, there may be software problems that have not been
discovered and corrected. If a problem occurs, please contact us via phone
(425-643-9866), email (seabird@seabird.com), or fax (425-643-9954) with the
following information:

* Instrument serial number

* Version of the software originally shipped with the instrument
* Version of the software you are attempting to run

»  Complete description of the problem you are having

If the problem involves the configuration or setup of the software, in most
cases a phone call to Sea-Bird will be sufficient to solve the problem. If you
phone, we would appreciate it if you would be ready to run the software
during the phone conversation.

If the problem involves data processing, you may be asked to send a sample of
the data to Sea-Bird for evaluation.

Known Bugs/Compatibility Issues

1. Some users have reported that SBE Data Processing isincompatible with
Windows NT when:
* Internet Explorer isinstalled on Windows NT, and
» Active Desktop wasinstalled from Internet Explorer 4.0.
Problem Symptoms. SBE Data Processing works, but Internet Explorer
does not operate properly. Problemsinclude error messages upon opening
Internet Explorer, and/or the inability to cut, paste, copy, delete, or rename
filesin Internet Explorer. Uninstalling SBE Data Processing eliminates
the problem with Internet Explorer.
Solution: Uninstall Active Desktop before installing
SBE Data Processing. Internet Explorer and SBE Data Processing
will work properly.
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